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Read This First

This Isodat 2.0 Operating Manual describes the features that have been 
added to ISODAT NT.

The Isodat 2.0 Operating Manual includes the following chapters:

Survey of recent Features in Isodat 2.0 gives an overview of the new and 
improved features.

Chapter 1: Hardware-related Features describes the improved and added 
features that concern the hardware.

Chapter 2: Evaluation-related Features describes the features that concern 
the evaluation.

Chapter 3: Script-related Features describes the script-related features that 
have been integrated or improved.

Chapter 4: Reporting-related Features describes the improved and added 
features that concern the reporting.

Chapter 5: Miscellaneous Features describes miscellaneous features that 
have been added or improved.
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___________________________________________________________________________ Isodat 2.0
Changes to the Manual and Online Help
To suggest changes to this manual or the online Help, please send your 
comments to:

Editor
Thermo Electron (Bremen) GmbH
Finnigan Advanced Mass Spectrometry
Product Marketing
Barkhausenstr. 2

D-28197 Bremen

Germany

e-mail: documentation@thermo-bremen.com

You are encouraged to report errors or omissions in the text or index.
Thank you.
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Isodat 2.0_________________________________________________________________________________
Abbreviations
The following abbreviations are used in this and other manuals and in the 
online Help.

A ampere

ac alternating current

ADC analog-to-digital converter

AP acquisition processor

APCI atmospheric pressure chemical ionization

API atmospheric pressure ionization

ASCII American Standard Code for Information 
Interchange

b bit

B byte (8 b)

baud rate data transmission speed in events per second

°C degrees Celsius

cfm cubic feet per minute

CI chemical ionization

CIP carriage and insurance paid to

cm centimeter

cm3 cubic centimeter

CPU central processing unit (of a computer)

CRC cyclic redundancy check

CRM consecutive reaction monitoring

<Ctrl> control key on the terminal keyboard

d depth

DAC digital-to-analog converter

dc direct current

DDS direct digital synthesizer

DEP™ direct exposure probe

DS data system

DSP digital signal processor

EI electron ionization

<Enter> enter key on the terminal keyboard
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___________________________________________________________________________ Isodat 2.0
ESD electrostatic discharge

ESI electrospray ionization

eV electron volt

f femto (10-15)

°F degrees Fahrenheit

ft foot

FTP file transfer protocol

g gram

G Gauss; giga (109)

GC gas chromatograph; gas chromatography

GC/MS gas chromatograph / mass spectrometer

GND electrical ground

GPIB general-purpose interface bus

GUI graphical user interface

h hour

h height

HPLC high-performance liquid chromatograph

HTML Hyper Text Markup Language

HV high voltage

Hz hertz (cycles per second)

ICIS™ Interactive Chemical Information System

ICL™ Instrument Control Language™

ID inside diameter

IEC International Electrotechnical Commission

IEEE Institute of Electrical and Electronics Engineers

in. inch

I/O input/output

IS extraction standard

ISTD internal standard

k kilo (103, 1000)

K kilo (210, 1024)

kg kilogram

l length
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Isodat 2.0_________________________________________________________________________________
L liter

LAN local area network

lb pound

LC liquid chromatograph; liquid chromatography

LC/MS liquid chromatograph / mass spectrometer

LED light-emitting diode

µ micro (10-6)

m meter

m milli (10-3)

M mega (106)

M+ molecular ion

MB Megabyte (1048576 bytes)

MH+ protonated molecular ion

MID multiple ion detection

min minute

ml milliliter

mm millimeter

MS mass spectrometer; mass spectrometry

MS MSn power: where n = 1

MS/MS MSn power: where n = 2

MSn MSn power: where n = 1 through 10

m/z mass-to-charge ratio

n nano (10-9)

NCBI National Center for Biotechnology Information 
(USA)

NIST National Institute of Standards and Technology 
(USA)

OD outside diameter

Ω ohm

p pico (10-12)

Pa pascal

PCB printed circuit board

PID proportional / integral / differential

P/N part number
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___________________________________________________________________________ Isodat 2.0
P/P peak-to-peak voltage

ppm parts per million

psig pounds per square inch, gauge

RAM random access memory

RF response file

RMS root mean square

ROM read-only memory

RS-232 industry standard for serial communications

s second

RT retention time

SIM selected ion monitoring

SRM selected reaction monitoring

TCP/IP transmission control protocol / Internet protocol

TEF toxic equivalent factor

TEQ toxic equivalent

TIC total ion current

Torr torr

u atomic mass unit

V volt

V ac volts alternating current

V dc volts direct current

vol volume

w width

W watt

Note. Exponents are written as superscripts. In the corresponding online 
Help, exponents are sometimes written with a caret (^) or with e notation 
because of design constraints in the online Help. For example:

MSn (in this manual) Ms^n (in the online Help)

105 (in this manual) 10^5 (in the online Help)
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ELECTRON CORPORATIONx____________________________Isodat 2.0 Operating Manual_________________________



Isodat 2.0_________________________________________________________________________________
Typographical Conventions
Typographical conventions have been established for Thermo Electron 
Bremen manuals for the following:

• Data input

• Boxed information

• Topic headings

Data Input
Throughout this manual, the following conventions indicate data input and 
output via the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is represented in bold face letters. 
(Titles of topics, chapters, and manuals also appear in bold face letters.) 

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled F1.

• Any command that requires pressing two or more keys simultaneously is 
shown with a plus sign connecting the keys. For example, “press 
<Shift> + <F1>” means press and hold the <Shift> key and then press the 
<F1> key.

• Any button that you click on the screen is represented in bold face letters 
and a different font. For example, “click on Close”.
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___________________________________________________________________________ Isodat 2.0
Boxed Information
Information that is important, but not part of the main flow of text, is 
displayed in a box such as the one below.

Boxed information can be of the following types:

• Note – information that can affect the quality of your data. In addition, 
notes often contain information that you might need if you are having 
trouble.

• Caution – information necessary to protect your instrument from 
damage.

• Warning – hazards to human beings. Each Warning is accompanied by a 
Warning symbol.

Note. Boxes such as this are used to display information.
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Isodat 2.0_________________________________________________________________________________
Topic Headings
The following headings are used to show the organization of topics within a 
chapter:

Chapter 1
Chapter Name

1.2 Second Level Topics

Third Level Topics

Fourth Level Topics

Fifth Level Topics
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___________________________________________________________________________ Isodat 2.0
Reply Cards
Thermo Electron Bremen manuals contain one or two reply cards. All 
manuals contain a Customer Registration / Reader Survey card and some 
contain a Change of Location card. These cards are located at the front of each 
manual.

The Customer Registration / Reader Survey card has two functions. First, 
when you return the card, you are placed on the Thermo Electron Bremen 
mailing list. As a member of this list, you receive application reports and 
technical reports in your area of interest, and you are notified of events of 
interest, such as user meetings. Second, it allows you to tell us what you like 
and do not like about the manual. 

The Change of Location card allows us to track the whereabouts of the 
instrument. Fill out and return the card if you move the instrument to another 
site within your company or if you sell the instrument. Occasionally, we need 
to notify owners of our products about safety or other issues.
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Survey of recent Features in Isodat 2.0
Isodat 2.0_________________________________________________________________________________
Survey of recent Features in Isodat 2.0

The following features have recently been included in Isodat 2.0. They span 
any of the four basic topics Hardware, Evaluation, Scripts and Reporting, 
therefore drastically enhancing its flexibility on a broad basis:

Hardware Evaluation Scripts Reporting

Device editor Ratio editor ISODAT Script 
Language (ISL)

Export editor

Control panel 
designer

Standard editor Dynamic Variables 
Exchange (DVE)

Result 
workshop

Third party 
support

External data 
processing 
(script-controlled)

Debugging 
acquisition scripts 
and evaluation 
scripts
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Survey of recent Features in Isodat 2.0
Hardware-related Features _______________________________________________________ Isodat 2.0
Hardware-related Features

Device Editor
In addition to the “classical” predefined devices, users can create specific 
devices completely on their own. The device editor is used to

• create new devices

• modify existing devices

Panel design
After creating new own devices users can modify and graphically customize 
their visualization in any application. This panel design is markedly assisted 
by several graphical objects. The control panel designer is used to

• create new control panels

• modify existing control panels

Third party support
The third party support concerns Trace GC, AS 2000, Agilent 6890 and the 
CTC autosampler.
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Survey of recent Features in Isodat 2.0
Isodat 2.0___________________________________________________________ Evaluation-related Features
Evaluation-related Features

Ratio editor
The ratio editor allows to determine

• element/molecule ratios
(by simply selecting denominator and divisor from lists)

• intermolecular/interelement ratios
(i.e. ratios between different elements and molecules)

Standard editor
The standard editor allows to define

• element/molecule standards

• interelement/intermolecular standards

External data processing (script-controlled)
• Edit data in user-defined scripts via the ISL interface.

• Perform flexible ion corrections by changing a- and k-factors in 
predefined algorithms.
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Survey of recent Features in Isodat 2.0
Script-related Features __________________________________________________________ Isodat 2.0
Script-related Features
Users can access, edit and run ISL scripts to control and facilitate data 
evaluation.

External Acquisition Control
• User-defined process control with multiple threads via the ISL interface

• The user can define dynamic variables via Dynamic Variables Exchange - 
DVE - and modify them in the method (script-dependent parameter).

• The user can define parameters for devices that are used in any script 
(device-related parameters).

Debugging scripts and parameter control
• Debug acquisition scripts and evaluation scripts stepwise while the 

processes are running. Control the variables, stacks, threads and functions 
involved.
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Survey of recent Features in Isodat 2.0
Isodat 2.0____________________________________________________________ Reporting-related Features
Reporting-related Features

Export Editor
• To export templates, use the drag&drop functionality of the export editor.

• Define multiple templates for one export cycle. Export to the formats 
“Excel”, “*.wk1” and “*.csv”.

ResultWorkshop
• Any Isodat 2.0 objects and graphical objects can be placed arbitrarily on a 

page and tailored before being printed.
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Chapter 1
Hardware-related Features

This chapter contains the following topics:

• Device Editor

• Panel Design

• Third Party Support
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Hardware-related Features
Device Editor _________________________________________________________________ Isodat 2.0
1.1 Device Editor
Principle: In addition to the predetermined “classical” devices, user-specific 

devices can personally be created. Before using them for the 
various applications, they can furthermore be modified, 
graphically customized and triggered.

Opening the Configurator

1. Start Isodat .

2. Open the Configurator.

3. In the Configurator, choose Edit > Advanced Mode.
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Hardware-related Features
Isodat 2.0_______________________________________________________________________Device Editor
4. Press OK to enter Advanced Mode.

5. Note that Advanced Mode is displayed down right above the system tray.

6. Click the Devices tab.

Note. Creating and editing of user devices is impossible in Normal Mode!
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Hardware-related Features
Device Editor _________________________________________________________________ Isodat 2.0
Creating a new User Device

1. The window shown above is called Configuration Editor.
The devices predefined by Thermo Electron are shown in its right pane.

2. To create a new user device, right-click somewhere in the pane.

3. The Add User Device button appears. Click on it.

4. A new user device has been created and added to the predefined devices.

5. Give it a significant name (e.g. “Device 1”).

Note. Do not click on an existing device!
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Hardware-related Features
Isodat 2.0_______________________________________________________________________Device Editor
Editing a new User Device
The new user device just created contains nothing and must now be specified.
To edit it proceed as follows:

1. Right-click on the device:
Delete will remove the device.
Duplicate leads to another new user device.
Properties allows to specify properties of the device itself (e.g. IDs).
Rename assigns a new device name.
Edit allows to specify properties of the objects that are components of the
device.

2. Select Edit or double-click the device.

3. The Device Editor appears.

4. Mark the first object intended (e.g. a Valve).

5. Drag&Drop it to the right pane.

Device Editor
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Hardware-related Features
Device Editor _________________________________________________________________ Isodat 2.0
6. Repeat this with further objects until your device is complete.

7. You can revise your decisions by a right-click on an object:
Delete removes the object. To delete more than one object, mark them by 
<Shift> or <Ctrl> before pressing Delete.
Properties gives detailed object information.
Rename assigns an alternative object name.
View Icons shows the objects as icons.
View List shows the objects in a list.

8. Select Properties to define the properties of an object (e.g. of a valve).
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Hardware-related Features
Isodat 2.0_______________________________________________________________________Device Editor
9. The parameters to be specified in the particular box differ between 
objects.

Example: The case of a valve

• Optional: if this checkbox is marked, you will be asked during each 
drag&drop whether the corresponding valve has been installed at all.

• Standard Inlet: this checkbox must be marked, if it is a standard inlet 
(e.g. Reference 1). If so, the valve will be available at “Standard 
Ports” in the Continuous Flow Method.

• Installed: Under certain conditions hardware is optional. If it is 
optional, you are asked during insertion, whether the valve has been 
installed or not.

• Monitor during Acquisition: Mark this checkbox, if you want the 
status of this object to be monitored during acquisition.

10. Make your decisions and finally confirm by OK.

Note. This check box is system-controlled. Always keep it marked!

superclass (e.g. hardware)

class (object, e.g. valve)

Each object has its own box (i.e. 
parameter set).

This box is specific for a valve.
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Hardware-related Features
Panel Design _________________________________________________________________ Isodat 2.0
1.2 Panel Design
Principle: Besides to creating and editing a new user device in the 

Configurator (see topics Creating a new User Device on 
page 1-4 and Editing a new User Device on page 1-5) you can 
customize its visualization in any application. This is called Panel 
Design.

Creating a Visualization

1. Start an arbitrary application, e.g. “Dual Inlet ACQ”.

2. Press the New button .

3. Press Peripheral Visualization Editor Dll and confirm by OK.
The Panel Editor will appear.
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Hardware-related Features
Isodat 2.0_______________________________________________________________________Panel Design
4. The entire document is called Control Panel Designer.

5. The empty working area on the right is utilized for panel design.

 

Pool of all hardware parts available, incl. 
 
� new user devices created on your own 

 
� graphical objects 

empty working area for peripheral design 
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Hardware-related Features
Panel Design _________________________________________________________________ Isodat 2.0
Two violet lines enclose it, one in vertical and one in horizontal direction. 
They serve as an orientation aid: to ensure identical sizes and appearances 
of the different dialogs within the working area use the vertical and 
horizontal rulers (e.g. always create standardized dialogs of 
480 pixels * 480 pixels).
Use the sizing handle at the edge to adjust the dimensions of the actual 
dialog.

Panel Design using Hardware Components
Principle: Thermo Electron still predefines the “classical” panels for the 

standard peripherals and devices. You can now change them.
In addition, you can combine single hardware components or 
peripherals to design complete panels on your own, e.g. using 
your new user devices (see topic Creating a new User Device on 
page 1-4).

• Drag & drop a hardware component into the working area.

Panel Design using Graphical Objects
Principle: Graphical objects are used as an illustration aid for predefined 

and self-designed hardware devices (see topics Creating a new 
User Device on page 1-4 and Editing a new User Device on 
page 1-5).
Graphical objects are mostly passive as they are not involved in 
hardware actions. The only exception, Visual Object Button, 
describes actions, as it actively allows scripts to be accessed and 
executed.
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On the contrary, active hardware and hardware actions are 
summarized directly beneath “Available Hardware Parts” (see 
topic Creating a Visualization on page 1-8).

Panel design using graphical objects will be described in detail only for 
Visual Object Text. The properties of the other graphical objects are very 
similar. Therefore, only their particularities will be discussed.

The following six graphical objects are available:

Visual Object Text
Principle: Use text within a text box to describe the function of single 

hardware components, combinations of them or even complete 
panels.

1. Click on a graphical object.

2. Drag & drop it into the working area (e.g. “Visual Object Text”).
The graphical object will be shown on the right side (e.g. a text box).

3. To change its position, click into the box, keep the left mouse button 
pressed and move your mouse.

4. To change its dimensions, use the sizing handles at the edges of the 
object.

• Visual Object Text • Visual Object Pipe
• Visual Object Groupbox • Visual Object Checkbox
• Visual Object Button • Visual Object Bitmap

sizing handles
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5. Note that an entry appears in the Peripheral box above the working area 
(e.g. “Visual Object Text”).

6. The graphical object can be modified by double-clicking it.

7. Text type in the text to be displayed in the text box.

8. Color define text color and color of the background. To display the 
background color, unmark the “Transparent” check box. To display a 
background picture, mark it.

9. Define Font, Font Size, Alignment and Style of the text.

10. Scale Text The text can further be scaled: if the checkbox is marked, the 
text dimensions will be changed depending on the working area’s size. If 
it is unmarked, the text dimensions remain as originally set.

ISL ID assign an ISL ID to the 
graphical object. Via this ID, 
the object can be analyzed by 
ISL scripts. This makes 
especially sense in case of text 
fields and checkboxes.

Border choose between four 
rectangular border types 
around the text box or, by 
“None”, select no border at all.

Type the name of a graphic as 
background picture or click 
the folder symbol to specify 
its path.
It can be stretched to span the 
entire text box or be 
transparent.
Gif-files can not be used as 
background pictures within 
text boxes.

Dialog 0

Dialog 1

Dialog 2
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11. Transparent The entire object will be displayed transparent, if the 
checkbox is marked. Thereby, in case of several text boxes, one or more 
of them can be covered by other objects.

To increase clarity, use <<. Thereby, single dialogs can selectively be 
masked.

12. Define the properties of the graphical object. Note that most of your 
statements are updated immediately. Finally, confirm by OK.

Visual Object Pipe
Principle: This visual object serves to represent gas flows through pipes or 

capillaries (i.e. layout of piping systems).

1. After drag&drop, a pipe is displayed.
It is recommended to increase the surrounding box above maximum 
spread of the pipe using the sizing handles of the box.
The pipe can then be edited by a double-click.

2. Assign an ISL ID and choose a border type as was shown for a text.

3. Finally, confirm by OK.

4. Change the shape and orientation of the pipe inside the box using the 
sizing handles at the ends of the pipe.

5. Change the dimensions of the box using its sizing handles (according to 
the dimensions of the piping system to be represented).

6. Move the box that contains the pipe by a click in the box and keep the left 
mouse button pressed while moving your mouse.
________________________ Isodat 2.0 Operating Manual _________________ 1-13Thermo
ELECTRON CORPORATION



Hardware-related Features
Panel Design _________________________________________________________________ Isodat 2.0
7. To represent branched gas flows, a right-click on a sizing handle allows to 
insert new points or to delete old ones. A left-click confirms the new 
point.

Visual Object Groupbox
Principle: This graphical object merely serves as visualization aid as it 

bunches together several objects optically - not logically - within 
one box. The groupbox is moved as a whole, i.e. the single 
objects within it are moved together without changing their 
relative positions.

1. After drag&drop, a groupbox is displayed, which can be edited by a 
double-click.

2. To define its properties and to modify its dimensions, refer to Visual 
Object Text.
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Visual Object Checkbox
Principle: This object visualizes that parameters must be checked by a script 

(e.g. the parameter “Text” or an ISL ID). A checkbox can be 
combined with a button.

1. After drag&drop, a checkbox is displayed, which can be edited by a 
double-click.

Note the additional dialog Dimensions.

2. Type a number to define the dimensions of the checkbox (default: 13).

Visual Object Button and Script Editing
Principle: A button can be used to completely control various kinds of 

scripts externally: apply a script to a button to get it processed 
after the button has been pressed.

Example: Via the ISL ID, the script verifies whether a valve is open and 
whether the user has marked or unmarked the corresponding 
checkbox.

Note. To mark or unmark a checkbox, switch to Simulation Mode. This is 
impossible in Design Mode.
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1. After drag&drop, a button is displayed in the shape of a text box, which 
can be edited by a double-click.

2. ISL ID Type a significant name for the ISL ID (e.g. “Open Valve #1”, if 
the ISL ID will be used to verify the status of valve #1).

3. Text Type a significant name for the button (e.g. “Open Valve #1”, if the 
button will be used to start a script that controls the status of valve #1).

Note the additional dialog.

Script To apply a script to the button, type the name of an ISL-script (e.g. 
“Autofocus Delta + 253.isl”) or click the folder symbol to specify its path.

Dialog 3
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Mode To define what is intended with the script, choose between:

Execute Script The script will simply be executed when the button is 
pressed.

Edit Dyn. Externals Dynamic Externals are dynamic variables within 
scripts that can be changed externally here.

Edit Hardware Components Changes hardware parameters, a 
particular type of Dynamic Externals.

4. Switch to Simulation Mode by a right-click.

In Design Mode, no effects will be obtained.

5. Finally, click on the button. The process, which has been specified at 
Mode will run (e.g. the script is processed).

Example: Edit Dyn. Externals

1. Choose Edit Dyn. Externals and select a script.

2. Confirm by OK.

3. The symbol indicates that editing is possible (not a simple execution as 
usual).

4. Right-click somewhere on the working area.

5. Switch to Simulation Mode.

6. In Simulation Mode, click the button.
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7. Edit the dynamic externals across the different tabs (e.g. “accelerating 
voltage”). The tabs and positions where the variables occur are stated 
together with their dialog identifiers (*.iso indicates the future parameter 
set of an *.isl script).

8. Finally, confirm by OK.

Script editing (case of dynamic externals)

1. To open a script, press the Open button .
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2. Select the script to be opened (e.g. “Autofocus Delta + 253.isl” in the 
directory \Finnigan\ISODAT NT\Global\ISL).

3. Confirm by Open and wait until the script is loaded.

Principle: The script above controls the occurrence of dynamic externals in 
their dialogs (i.e. where and how they appear). It is organized in 
“blocks”.
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A “block” covers any of the dynamic externals that will occur on 
the same tab page. A single row inside the “block” defines details 
of one particular dynamic external.
Use script editing to customize the appearance of variables, 
dialogs and tab pages totally on your own. E.g. change a dialog 
identifier to modify the text representing a dynamic external.
After editing it, a script can be tested in Simulation Mode.

The uppermost “block” of the script is shown above.

dynexternal declares a dynamic external, i.e. a variable that can be shown as 
part of a dialog (e.g. b_DeltaAcceleratingVoltage, b_DeltaEmission, etc.).

bool is the type of this variable (as is integer, channel etc.). As a true/false 
decision, it implies a checkbox that is either marked or unmarked (E.g. 
channel would be another type of variable leading to a list of the channels 
which are available in the actual gas configuration).

DeltaAcceleratingVoltage, DeltaEmission, etc. are the declared dynamic 
externals themselves.

1 indicates that the checkbox in the dialog is marked, i.e. the dynamic 
external will be checked. In case of 0, the checkbox in the dialog is unmarked 
and therefore, the dynamic external will not be checked.

1 2 3

1
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“Autofocus Delta” is the name of the tab page where the dynamic external 
will occur.

PosX describes the horizontal position of the dynamic external on that tab 
page (e.g. 5).

PosY describes the vertical position of the dynamic external on that tab page 
(e.g. 20).

Dialog Identifier serves as representation to identify the dynamic external by 
describing the text that will occur next to it in the dialog (e.g. “Accelerating 
Voltage”, “Emission”, “Trap”, etc.).

Example: Edit Hardware Components
A hardware device is characterized by hardware-specific parameter sets of its 
own (e.g. the carbonate device). As these parameters are used during 
acquisition, they will be loaded by acquisition scripts.

1. To load these parameter sets, press the Open button .

2

3
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2. Select the script to be opened (e.g. “Dynexternals_inc.isl” in the directory 
\Finnigan\ISODAT NT\Global\ISL\Hardware Parameters\Carbonate 
Device). Confirm by Open and wait until the script is loaded.

3. At the “TAB_PAGE” entry, note the term @Hardware@ before the name 
of the tab page begins (e.g. “Pressure Pre Adjust”).

Hardware parameters are a particular class of dynamic externals. The only 
difference is, that they are filtered when being displayed. To let a dynamic 
external be displayed as a hardware parameter (i.e. as a hardware parameter 
set of a device), it must be marked by the preceding term @Hardware@ as is 
shown above. If this term is missing, it will not be displayed as hardware 
parameter, but as a “normal” dynamic external.
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Visual Object Bitmap
Principle: This visual object illustrates relationships graphically.

1. After drag&drop, a default bitmap is displayed, which can be edited by a 
double-click.

2. ISL ID / Border: refer to Visual Object Text.

3. Type the name of the picture of interest or click on the folder to specify its 
path. Choose between a variety of graphic formats:
In contrast to Visual Object Text, even gif-files can be used here as 
background pictures (animated or not).
E.g. use an animated gif to represent pumps at work.

4. Stretch / Transparent: refer to Visual Object Text.

even gif-files 
can be used 
here
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Context Menu
Principle: In Design Mode (default), the context menu appears upon a 

right-click on the working area. It offers a wide variety of 
commands, which will be discussed one by one in detail. The 
context menu is not available in Simulation Mode.

• Design Mode Default Mode, used to edit graphical objects and hardware 
components.

• Simulation Mode Used to execute scripts and change parameters after 
the editing phase in Design Mode. To return to Design Mode, right-click 
on the working area and then press Switch to <Design Mode>:
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• Properties
Shows the Properties box of the object actually selected (e.g. a pipe) to 
edit its parameters. Therefore, this command is inactive until a graphical 
object has been placed onto the working area.

• Set Background Color

a. Click on your favorite color or on Define Custom Colors >>.

b. Then, confirm by OK.
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Select more than one object

1. To handle more than one object simultaneously as a group, first select 
them all by keeping the <Ctrl> key pressed.

The object that was selected at last is active and therefore highlighted red 
(e.g. “Text”). As master, it determines all adjustments, i.e. the other 
graphical objects will be arranged relatively to it.

Special case: a single object can also be grouped (i.e. group consisting of 
only one element). Then, you can proceed with Copy, Cut, Paste or 
Delete as will be described below.

Copy / Paste: 
a. Select one or more objects (see above).

b. Right-click and press Copy.
Right-click and press Paste.
Find the position of the copied object(s) by moving them with your 
mouse.

c. After the position has been found, perform a left click.

Cut / Paste: 
a. Select one or more objects (see above).

b. Right-click and press Cut.
Right-click and press Paste.
Find the position of the cut object(s) by moving them with your 
mouse.

c. After the position has been found, perform a left click.

Delete:
a. Select one or more objects (see above).

b. Right-click and press Delete.

<Ctrl>
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c. Confirm by Yes.
As an alternative, use the taskbar above the working area:

Adjust:
Use this command to arrange objects relative to each other.

a. Select one or more objects (see above).

b. Right-click and press Adjust.

c. Choose Adjust Left, Adjust Top, Adjust Right or Adjust 
Bottom to match the relative positions of the selected objects.
The object that was selected at last is highlighted red.
As an alternative, use the taskbar above the working area:

d. Choose Same Size, Same Height or Same Width to match the 
dimensions of the selected objects.
The object that was selected at last is highlighted red and forces its 
dimensions on the other selected objects.
As an alternative, use the taskbar above the working area:
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Lock:
Protects position and dimensions of an object from being changed.

a. Click on the object to be locked.

b. Right-click and press Lock. A key symbol appears.

Unlock:
Allows changing position and dimensions of an object again.

a. Click on the locked object.

b. Right-click and press Unlock. The key symbol disappears.

To create an optical group, group boxes are used (see above).

Contrary to that, use the Group command to obtain a logical group. Ungroup 
breaks up the group leading to independent graphical objects again.

Group:
Notice that a new entry appears in the Groups box above the working area 
(e.g. “Group Index 1"). It denotes that the objects shaded gray in the 
Peripheral box now form a group.

Click somewhere on the working area. 
Notice that each object of the group is labeled as in the Groups box.

Ungroup:
a. Click on a group to mark it.

a. Right-click and press Ungroup.

b. Click somewhere on the working area. The group no longer exists, 
but individual objects do.

Lock

Unlock

Group
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You can combine the commands of the context menu, e.g. group objects that 
have previously been locked.

“Reset” button
Principle: Use it to clear your actual working area with or without saving it - 

e.g. to create a new visualization. The fields “Peripheral” and 
“Groups” above the working area will be cleared as well.

1. On the taskbar above the working area press the Reset button .

2. If the actual visualization has never been saved before, you are asked to 
decide it now.

3. To save it, press Yes and refer to topic Saving a Visualization on 
page 1-30.
To discard your visualization without saving it, press No.
The working area will be cleared.

“Properties” button
1. On the taskbar above the working area, press the Properties button 

.

Combination of several graphical objects
Several graphical objects can be combined within one visualization.

Ungroup
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Saving a Visualization
1. After designing one ore more graphical objects, the entire visualization 

can be saved: press the Save or Save As button .

2. By default, the visualization will be stored in the folder \Dynamic 
Devices. Accept it or choose another folder.

3. Type a significant file name and accept the extension Peripheral 
Visualization.

4. Press Save.

Loading a Visualization
Thermo Electron delivered some predefined peripheral visualizations. Load 
one of them or one you created on your own as follows.

1. In the Application Mode, press the Open button .
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2. Search the folder that contains the visualizations (e.g. \Dynamic Devices).

3. Choose the visualization to be loaded. Press Open.

4. The visualization can be used directly or edited.
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1.3 Third Party Support
Principle: Thermo Electron offers configurations and methods to operate 

the following devices offered by external manufacturers (i.e. for 
“external devices”):

PAL autosamplers, e.g. GC PAL - as the direct successor of A200S - and 
Combi PAL, are to be run in A200S mode. Therefore later on, select A200S. 
The extension is A200S as well.

Adjusting the Properties of an external 
Device
Principle: Many properties of the external manufacturer's device can be 

adjusted in the Configurator.

1. Open the Configurator .

2. Press the Devices tab .

• A200S • AS2000
• Agilent GC 6890 • Trace GC
• PAL autosamplers

(GC PAL and Combi PAL)
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3. Right-click or double-click on the external device whose properties you 
want to adjust (e.g. “A200S”).

4. Click the Properties button.

5. The Configuration box appears. It allows individually adjusting the 
properties of the external device that has been selected. The adjustment of 
properties will now be shown for each of the various external devices.

Note. If you have a PAL autosampler, i.e. a GC PAL or a Combi PAL, select 
A200S!
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Trace GC

Configure your Trace GC as follows:

1. Double-click or right-click the Trace GC button .

General tab

2. At Serial Port, specify COM 2 as serial port your Trace GC is connected 
to.

Note. For further details about injectors and detectors, refer to the manual of 
the Trace GC.
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3. At Options, choose between several pressure units (e.g. kPa).

Setup via Trace GC (using the Get button)
Principle: You can edit a method not only via the Isodat software, but also 

at the Trace GC itself (i.e. at the hardware side). The method 
provided by the Trace GC can then be loaded into Isodat and will 
be used instead of the statements you declared in Isodat.

In case of Agilent 6890 GC and A200S, the editing options via the Isodat 
software are much more restricted. Therefore, many parameters must be 
adjusted externally, i.e. at the hardware.

Note. The Get button always enables upload of GC parameters. Then, all 
inlets - i.e. injectors - and detectors are selected (in this case, it is 
unnecessary to specify these parameters via Isodat).
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Setup via Isodat 2.0 (i.e. manual setup)
Inlets tab

• At Inlets tab, specify both the left and right injectors.

Example: Left: SSL and Right: OCl

Note. In this version, Thermo Electron supports SSL and OCl as injector 
types, but not PTV.

SSL split/splitless injector
OCI on-column injector
HOTOC high oven temperature cold on-column injector
LVOCI large volume on-column injector
PTV programmable temperature vaporizing injector
Not used for GC-IRMS:
PKD packed column injector
PPKD purged packed column injector

Note. If you select “None”, the respective tabs will not occur in the method 
later on!
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Detectors and Data tab

1. Specify the detectors available (left, right and auxiliary detector).In many 
cases, None will be selected (default), especially at Auxiliary. Mostly, 
only one detector will be present, i.e. left or right, whereas usage of two 
detectors (i.e. left and right) is rare.

2. The Get button will automatically upload the correct hardware position 
(i.e. whether a detector is located left or right).

Used detectors are:

FID Flame Ionization Detector

ECD Electron Capture Detector

NPD Nitrogen Phosphorus Detector

TCD Thermal Conductivity Detector
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Example: As left detector you might have a FID, and an ECD as the right 
one.

3. Select the data sources (i.e. channel sources) to be read out from Trace 
GC via different channels. Three channels - 1, 2, and 3 - can 
simultaneously be read out and will be displayed in the Acquisition 
module.

Example: At Data Source, assign “Det-A” to Channel 1, “Det-B” to 
channel 2 and “Oven actual” to Channel 3. (see above.)
At Channel Name, type a significant name for each channel 
(e.g. “FID” for Channel 1, “ECD” for Channel 2, “Oven actual 
“for Channel 3, see above).

4. At Scan Rate (Hz), select the sampling rate for the respective channel 
between 1 Hz and 300 Hz (default: for each channel: 10 Hz). It is possible 
to scan one channel in a given period of time, only. 
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5. Choose between pressure mode and flow mode via the checkbox (default: 
checkbox is marked, i.e. flow mode).

6. Select either 50 Hz or 60 Hz (default) for the line frequency.

Auxiliary and Oven options tab

• If an ultrafast module exists, you can activate it by marking the checkbox.

Agilent 6890 GC

Configure your Agilent 6890 GC as follows:

1. Double-click or right-click the Agilent 6890 GC button .

Note. For further details about injectors and detectors, refer to the manual of 
the Agilent 6890 GC.
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2. At Pressure Settings, choose the unit of pressure between psi, bar and 
kPa.

3. At Connection, specify COM2 as the computer's COM Port your Agilent 
6890 GC is connected to.
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ELECTRON CORPORATION1-40 ________________________Isodat 2.0 Operating Manual_________________________



Hardware-related Features
Isodat 2.0__________________________________________________________________ Third Party Support
4. At Inlet, specify both front and back inlet system, i.e. the injectors.

5. In both cases, choose between None, Split/Splitless and On Column: 

6. At Signals, indicate which detectors will be monitored on Signal Path 1 
and 2, respectively. In both cases, choose between None, Front Detector, 
and Back Detector.

7. Additionally, a broad variety of parameters can be adjusted, e.g. 
temperature- or flow-related data:

8. If you did not choose “None”, the Settings buttons will both be active. 
Press them in order to adjust Rate, Acquisition Mode and Format.

9. The sampling Rate can be adjusted between 0.1 Hz and 200 Hz (default: 
10 Hz).
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10. For Acquisition Mode, accept the default, SGL.

RUN: data acquisition only while the GC is in Run mode.

CON: GC will permanently be inquired (i.e. Continuous Mode).

SGL: Single run mode

11. At Format accept the default, BIN (other formats are DEC, HEX or 
CMP).

12. Finally, confirm by OK twice.

A200S

Configure your A200S autosampler as follows:

1. Double-click or right-click the A200S button .

2. Usually, the A200S autosampler is connected via COM 2.

3. Confirm by OK.

AS2000

Configure your AS2000 autosampler as follows:

1. Double-click or right-click the AS2000 button .

Note. For further details about injectors and detectors refer to the manual of 
the A200S autosampler.

Note. For further details about injectors and detectors refer to the manual of 
the AS2000 autosampler.
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2. Define how the AS2000 autosampler is connected (usually “through GC”, 
but it may also have a COM Port of its own).

3. Define the Start Mode (default: “Normal”).

4. At Sampler serves, choose between “Single injector” (default) and 
“DoublePro injector”.

5. Select the type of vial tray (default: 90 vial tray).

6. Again use the Get button, if you prefer to upload parameters from the 
AS2000 (i.e. from the hardware rather than from the Isodat 2.0 software).

7. Finally, confirm by OK.

Creating a new Method for an external 
Device
1. Ensure that a Configuration containing the complete external device (e.g. 

a GC II-III Interface + Trace GC + AS2000) has been established in the 
Configurator before. This guarantees that the functionality will be 
available in the measurement mode, i.e. in Acquisition mode.

2. Open the Acquisition module .
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3. Press the New button  in the appearing Acquisition window.

4. Mark the icon designed for your external manufacturer device: “6890”, 
“A200S”, “Trace” or “AS2000”.

5. Confirm by OK.

Method Structure of external Devices

Structure of a Trace GC Method

1. Double-click on the Trace icon . The Trace GC method opens. It 
is organized in tab pages.
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Oven tab

1. On the Oven tab, temperature ramps can be defined and added.

2. The initial temperature is displayed, e.g. 40 ºC, together with its 
duration,e.g. 1.00 min. When the ramp, e.g. Ramp 1 starts, a heating rate, 
e.g. 10.0 ºC/min, will be prevalent until the end temperature of this ramp 
is reached, e.g. 50 ºC. This end temperature will be kept for e.g. 1.00 min.
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3. Marking the Post Run Conditions checkbox assures that the parameters 
above will be applied after the run to condition the system or to switch it 
into the standby mode.

Temperature (ºC) prevailing temperature after the run

Time (min) duration of the post run parameters

Pressure Left (kPa) left pressure after the run

Pressure Right (kPa) right pressure after the run

4. Specify an oven run time or a specific time.

5. Marking the Enable Cryo checkbox allows the cryogenic equipment to 
turn on at a setpoint temperature.

6. Max Temp (ºC) limits the oven temperature to the setpoint.

7. Prep Run Timeout (min) returns the GC to standby mode, if injection 
does not occur within the time set.

8. Equilibration Time (min) allows the oven temperature to stabilize after 
cooling for the duration of time set (injector and detector temperature as 
well).
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Run Table tab
The Run Table tab is used only for special applications, e.g. control of 
external valves, switching of valves. During usual applications, however, it 
remains empty.

• At the Run Table tab, you can program events to happen during a run. If 
no run events have been programmed, the list will be empty. To create a 
run time event, press the Add button.

Example: A valve could be switched (opened/closed) or an external event 
from another device can be programmed.

Eight external events are available, but each extra valve (i.e. other valves 
than inlet valves) takes up two external events: one to open the valve, the 
other one to close it. If you have one valve configured, only six external 
events will appear. The run table events occur on a decimal-minute clock, 
that begins counting when the run starts.

Structure of an Agilent 6890 GC Method

1. Double-click on the 6890 icon .
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The Agilent 6890 GC method opens. As with other methods, it is 
organized in tab pages.

2. Temperature Program Enable: Enable the checkbox to load a 
temperature program. It is possible however by clearing the checkbox, to 
specify parameter values on the “Oven Method” tab without loading the 
temperature program.

Note. You must have specified injector(s) and detector(s) to let the three tabs 
“Front”, “Back” and “Detector” appear. If you specified “None”, the 
respective tab will not appear.
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Oven Method tab

Cryo on enables cryogenic cooling, if a cryogenic valve is installed and if 
the coolant is available.
The cryogenic valve allows you to operate the oven below ambient 
temperature. The minimum attainable oven temperature depends on the 
type of valve installed.

Quick Cryo Cooling on is different from “Cryo on”: it makes the oven 
cool faster after a run than it would without assistance. This feature is 
useful when maximum sample throughput is necessary, however it uses 
more coolant. “Quick Cryo Cooling” turns off soon after the oven reaches 
its setpoint and “Cryo” takes over, if needed.

Ambient Temp denotes the temperature in the laboratory. This setpoint 
determines the temperature at which cryogenic cooling is enabled.

Set “Ambient Temp” to + 25 °C for regular cryo operation.

Set “Ambient Temp” to + 45 °C for quick cryo cool.

Max Temp denotes the maximum allowable oven temperature setpoint. 
Some accessories, such as columns and valves, have specific temperature 
limits.

Prep Run Timeout: The Prep Run function is activated to prepare a run. 
If all setpoints are reached, the instrument is waiting for injection 
(timeout).

The Prep Run function is used for the following functions:

Gas saver - cancels gas saver flow and brings inlet flow to its setpoint 
value.

Splitless injection - closes the purge valve.

Pulsed split or splitless injection - increases the inlet pressure to the 
pulse setpoint.
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Solvent vent injection - changes the inlet pressure to the vent pressure 
setpoint and the split vent flow to the vent flow setpoint.

Equilibration Time: This time is required for the oven temperature to 
equilibrate after the temperature has been modified. Equilibration time 
begins when the actual oven temperature comes within 1 °C of the oven 
temperature setting. The equilibration time setpoint can be 0 to 999.99 
min.

Making a temperature-programmed run
You can program the oven temperature from an initial temperature to a final 
temperature using up to six ramps during a run. Multiple ramps can also be 
programmed for temperature decreases as well as for increases.

1. Establish a temperature program, i.e. specify the temperature 
characteristics over time:

Example:

a. Insert lines by pressing  and delete lines by pressing .

b. Type a start value for the temperature into the Temp column (e.g. 
50 ºC).

c. Type a time value into the Time column (e.g. 15 min). Thus, the 
temperature will be kept at its start value for this period of time.

d. Type a temperature rate value into the Rate column (e.g. 10 ºC/min).

e. Type a temperature value into the Temp column (e.g. 200 ºC). The 
temperature will be changed according to this rate until the 
temperature is reached.
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f. Type a time value into the Time column (e.g. 20 min). Thus, the 
reached temperature value will be kept constant for this period of 
time.

2. Marking the Post Run Conditions checkbox assures that the parameters 
above will be applied after the run to condition the system or to switch it 
into the standby mode.

Temperature (ºC) Temperature after the run (see Trace GC at 
Structure of a Trace GC Method on 
page 1-44).

Time (min) Duration of this temperature after the run (see 
Trace GC at Structure of a Trace GC 
Method on page 1-44).

Pressure Front (psi) Pressure at Front injector after the run

Pressure Back (psi) Pressure at Back injector after the run

3. Pressing the Upload Method button  enables the manual 
upload of a method just in time. However, the usual way is to fill out the 
Oven tab page and save it, before you call up this method in the sequence. 
When the sequence is started, the method will be loaded line after line.
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Front tab

1. Injector Mark the checkbox to set an injector.

2. Mode Select the injection mode. Choose between Split, Splitless, Pulsed 
Split and Pulsed Splitless.

Note. The Front tab only appears, if you did not select None above at “Front 
Injectors”. Usually, “Split/Splitless” has been chosen.

Note. If you unmark the checkbox, the parameters within the surrounding 
frame will not be loaded.
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3. Temperature (ºC) Temperature of the injector you selected (e.g. 220 ºC). 
The value depends on the actual application.

Injection Mode “Splitless”

If you selected Splitless at Mode:

• Purge Time (min) time, during which the split - i.e. the purge line - is 
closed, after injection (typically 1 min).

• Purge Flow (ml/min) flow used to purge the injector after the purge time 
has elapsed and the purge line has been opened again (considerably high, 
typically 100 ml/min).

Injection Mode “Split”

If you selected Split at Mode:

• Split Ratio is defined as Split Flow/Flow along the column.

• Split Flow (ml/min) depends on the Split Ratio. If you define a Split 
Ratio, a Split Flow will automatically be calculated and vice versa.

Example: A Split Ratio of 20 is calculated from a Split Flow of 40 ml/min 
and a flow along the column of 2 ml/min.
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Injection Mode “Pulsed Split”

Principle of the two Pulsed Modes: the transfer time along the injector is 
increased.

If you selected Pulsed Split at Mode (i.e. a modified split mode), the pressure 
will be increased for a definite period of time.

• Split Ratio: see above.

• Split Flow (ml/min): see above.

• Injection Pulse Pressure (psi): the pressure to be applied

• Injection Pulse Time (min): the duration of applying the pressure

Injection Mode “Pulsed Splitless”

Principle of the two Pulsed Modes: the transfer time along the injector is 
increased.

If you selected Pulsed Splitless at Mode (i.e. a modified splitless mode):

• Purge Time (min): see above.

• Purge Flow (ml/min): see above.
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• Injection Pulse Pressure (psi): see above.

• Injection Pulse Time (min): see above.

This box is only available, when you either selected Splitless or Pulsed 
Splitless at Mode. It defines the time at which the split line is closed:

• Direct before injection: the split line is closed immediately before 
injection.

• Auto Prep: enable or disable the Auto Prep functionality.

• At Time (min): define a time after which the split valve will be closed.

• Gas Saver: can be enabled by marking the checkbox.
The Gas Saver Mode is typical for the Splitless Modes (i.e. Splitless and 
Pulsed Splitless).

• Flow (ml/min): defines the flow value under gas saving conditions.

• Time (min): period, after which the Gas Saver Mode will start.

Example: To save gas, the Gas Saver Mode will start after 25 min. The 
split flow (e.g. 100 ml/min) will then be reduced to the value 
specified at flow (e.g. 20 ml/min).

Carrier Enable: enable or disable a carrier gas.

Note. If you unmark the checkbox, the parameters within the surrounding 
frame will not be loaded.
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Specify the mode in which you want to set the carrier gas. Thermo Electron 
recommends Constant Flow Mode, i.e. to work using a constant flow on the 
column. Other modes are Constant Pressure Mode, Ramped Flow Mode and 
Ramped Pressure Mode.

Constant Flow Mode

Flow (ml/min): flow of the carrier gas to be kept constant. It depends on the 
inner diameter of the column in use. Typical values may be:

for a column of 0.25 mm inner diameter: 0.8 ml/min - 1.2 ml/min

for a column of 0.35 mm inner diameter: 1.6 ml/min - 2.2 ml/min

Constant Pressure Mode

Pressure (psi): specify the pressure to be kept constant.
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Ramped Flow Mode

• Establish a flow program, i.e. specify the flow characteristics over time:

Example:

a. Insert lines by pressing  and delete lines by pressing .

b. Type a start value for the flow into the Flow column (e.g. 1 ml/min).

c. Type a time value into the Time column (e.g. 1 min). Thus, the flow 
will be kept at its start value for this period of time.

d. Type a flow rate value into the Rate column (e.g. 0.1 [ml/min]/min).

e. Type a flow value into the Flow column (e.g. 5 ml/min). Thus, the 
flow will be changed according to this rate until the flow value is 
reached.

f. Type a time value into the Time column (e.g. 2 min). Thus, the 
reached flow value will be kept constant for this period of time.
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Ramped Pressure Mode

• Establish a pressure program, i.e. the pressure characteristics over time.

Example:

a. Insert lines by pressing  and delete lines by pressing .

b. Type a start value for the pressure into the Pressure column (e.g. 
100 kPa).

c. Type a time value into the Time column (e.g. 10 min). Thus, the 
pressure will be kept at its start value for this period of time.

d. Type a pressure rate value into the Rate column (e.g. 10 kPa/min).

e. Type a pressure value into the Pressure column (e.g. 200 kPa). The 
pressure will be changed according to this rate until the value is 
reached.

f. Type a time value into the Time column (e.g. 5 min). Thus, the 
reached pressure value will be kept constant for this period of time.
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Back tab

1. Mark the Temperature Enable checkbox to load the parameters within 
the surrounding frame.

2. At Mode, choose between Track Oven and Ramped Temperature.
In case of Track Oven, the oven temperature will follow the injector 
temperature.

3. At Temperature, define the temperature value.
In case of Ramped Temperature, establish a temperature program for the 
injector. This is analogous to establishing a flow program or a pressure 
program (see above).

1. Again, at Mode, choose between Constant Flow, Constant Pressure, 
Ramped Flow and Ramped Pressure.

2. Define either the working flow/flow program or the working 
pressure/pressure program as has been shown above.

Note. The Back tab only appears, if you did not select None above at “Back 
Injectors”. Usually, “On column” has been chosen.
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Detector tab

1. Typically, choose the Front detector (e.g. at “Signal Path 1") and the 
Back detector (e.g. at “Signal Path 2").

2. Define the Temperatures for both detectors (e.g. 250 ºC and 150 ºC).

3. In addition to Front Detector and Back Detector, there is a wide variety of 
other parameters available as well.

Note. The Detector tab only appears, if you did not select “None” above at 
one of the “Detectors”. E.g. “FID” and “TCD” have been chosen.
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Structure of an A200S Method

PAL Setup

There are nine different methods available, which are maintained even if the 
power to the A200S is switched off: A200-1 to A200-9 (cf. the internal file 
names “Internal No. 1" to “Internal No. 9" at the “AS Method” column in 
topic Creating a new Sequence for an external Device on page 1-68).

1. Double-click on the A200S icon .The A200S method is divided 
into four sections.

Note. The PAL autosamplers (i.e. Combi PAL and GC PAL) are 
momentarily run via A200S mode!

Note. If you create a new file name however, the method is uploaded to the 
method A200S-1 in the control panel, and this method is overwritten!
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Actions, which are taken before injection

• Solvent Wash Cycles: To avoid contamination of the syringe and needle, 
they may be washed with solvent before the sample is picked up. This 
helps also to avoid air bubbles below the plunger because the syringe is 
wet afterwards and is more gastight.
Pre-injection is also a possibility to have a solvent plug with the volume 
of the syringe needle above the sample.

• Clean Cycle with Sample: This option is utilized when the solvent used in 
a post injection clean cycle is not compatible with the analysis, or when 
no pre-injection solvent clean cycle is used.
Set to zero when pre-injection solvent wash is used and you want a 
solvent plug on top of the sample to compensate for needle dead volume.

• Air Volume before Sample: Specifies the air volume that is pulled up 
after the needle is moved in the sample vial.
An air plug is set between sample liquid and the solvent plug by setting of 
solvent wash cycles. For this option, clean cycles with sample are not 
used.This option is not available for the PAL-Autosamplers (Combi-PAL, 
GC-PAL).

• Syringe Filling Cycles: This parameter serves to control the filling of the 
syringe. It may happen that some air bubbles remain below the plunger 
after the first pull up. If the plunger is moved up and down several times, 
these air bubbles are worked out.

• Syringe Filling Volume: All filling cycles, except for the last one, use the 
selected minimum filling volume.

• Syringe Pullup Delay: In this display, a delay between sample pullup and 
ejection while filling the syringe is selected. The same delay is used after 
the last plunger pullup until the syringe needle is moved out of the vial. 
This feature is especially useful for handling viscous fluids.
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• Syringe: Volume of the syringe in use

Actions, which are directly related to sample injection

• Sample Volume (µl): The sample volume to fill the syringe.

• Air Volume after Sample (µl): The air volume, that is pulled up after the 
needle is moved out of the vial. By pulling up some air after taking the 
sample, evaporation from the needle is reduced.

• Filling Speed (µl/s): The speed of the plunger movement can be selected 
for the filling cycles.

• Injection Speed (µl/s): The speed for sample injection

• Pre Injection Delay (s): After the needle of the syringe is moved down 
into the injector, it may be desirable to wait a certain time so that the 
needle warms up before the sample is injected, i.e. the plunger goes down 
(hot needle injection).

• Post Injection Delay (s): After the injection it is possible to wait for 
evaporation of the needle content before the needle is pulled out of the 
injection block.
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Actions, which are taken after sample injection

• Solvent Wash Cycles: After the sample has been injected, the syringe is 
cleaned by repeatedly filling it with solvent.

Structure of an AS2000 Method

• Double-click on the AS2000 icon . The AS2000 method opens.

General tab

• Sample (µl): the sample volume that will be injected (0–500 µl).

• Filling (µl): the sample volume used when flushing the syringe with the 
sample before finally taking it up (0–500 µl).
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• Air (µl): the air volume that will be injected after the sample (0–500 µl).
Air is injected to perceive clearly the sample amount within the syringe. 
Further, it facilitates positioning the sample to prevent it from 
instantaneous evaporation.

• Sample pull-up (µl/s): the velocity of lifting the plunger after the syringe 
has been immerged into the vial (1–100 µl/s).

• Injection (µl/s): the velocity of injection, i.e. velocity of pressing down 
the plunger after being introduced into the injector (1–100 µl/s).
Note that the sample-pull-up is performed very slowly compared to the 
rapid injection.

The syringe is flushed with the sample by repeatedly moving up- and 
downwards the plunger: Thus, before finally taking up the sample, it is pulled 
up into the syringe and flushed back into the vial (pull-up cycle) several times. 
Pull-up cycles are performed to cover the surfaces inside the syringe with the 
sample and to press out air bubbles (e.g. out of the needle volume).

• Pull-up cycles: Specify the number of pull-up cycles between 0 and 15. 
The default value is 5, whereas 0 means no pull-up cycle but 
instantaneously taking up the sample.

• Delay (s): the time between two subsequent pull-up cycles (0–15 s). The 
default is 0, i.e. the pull-up cycles follow directly one after the other 
(usual value). As rather viscous solvents need more time to flow along, it 
is advisable in such cases to use a delay (e.g. 1 s or 2 s). Note the sample 
pull-up speed value above.

• Pre-injection: number of cleaning cycles using solvent before injection 
(0–15). Choose the solvent (A, B, C or D) for purging.

• Post-injection: number of cleaning cycles using solvent after injection 
(0–15). Choose the solvent (A, B, C or D) for purging.
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• Sample: number of cleaning cycles using the sample (0–15, default: 1). 
The sample volume in µl is specified at Filling, see above.

• Pre-inj. (µl): solvent volume for cleaning cycles before injection 
(0–500 µl)

• Post-inj. (µl): solvent volume for cleaning cycles after injection 
(0–500 µl)

• Pre-inj. (s): delay between pulling down the needle and injection (0–63 s)

• Post-inj. (s): delay between injection and pulling up the needle (0–63 s)

Internal Standard tab
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In addition to the sample, an internal standard can be filled into the 
syringe.The internal standard is located in an external vial.

• Use internal standard: mark the checkbox to use an internal standard 
method. Thus, the following parameters become available:

• Internal standard volume (µl): the volume of the internal standard to be 
filled into the syringe (0–500 µl, default is 2 µl)

• Air gap mode: use an air gap (i.e. an air plug) to prevent the two liquid 
films of standard and sample from flowing into each other. Select Post 

(default) or Double  to define the position of the air plug 
relative to sample plug, solvent plug and internal standard plug (e.g. 
before or behind sample).

• Air gap volume (µl): the volume of the air gap (0–500 µl, default: 1 µl)

• Internal standard vial: the number of the vial that contains the internal 
standard. Choose between A, B, C, D and 1 to 90 (default: 90).

Saving a Method for an external Device
1. After you made your decisions throughout the tab pages of your method, 

save it by pressing the Save button .This will make the method 
available in later applications.
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2. Specify the folder for the method and type a significant name.

3. Accept the method-specific extension:

.gcm for Trace GC methods,

.6890 for Agilent 6890 GC methods,

.asm for AS2000 or HS2000 methods,

.A200S for A200S methods (cf. PAL autosamplers).

4. Confirm by Save.

Creating a new Sequence for an external 
Device

1. First of all, choose the correct Configuration (e.g. “Trace GC”).

2. After having created a method (see topic Creating a new Method for an 

external Device on page 1-43), press the New button  to create 
an associated sequence.
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3. Mark the Sequence button and confirm by OK.

4. Type your number of samples (e.g. 3) and confirm by OK.

5. The sequence is shown (e.g. a Trace GC sequence).

Note. Two methods occur, a GC method and an AS method!
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6. To make more or less columns visible, perform a right mouse click.

7. From the pull-down menu, select Columns.

8. To see a particular column, mark its checkbox. If you unmark a checkbox, 
the respective column will not be visible in the sequence.

9. Look at the GC method by a click upon . The actual line will be 
activated and occurs in bold style (e.g. 1, i.e. Sample 1). The column “GC 
Method” will be activated and occurs in bold style.

10. Choose between all GC methods you created before for the actual 
Configuration (e.g. “Trace GC”).

Example: The extension gcm denotes all Trace GC methods.

(e.g. “Trace 1.gcm” or “Trace 2.gcm” are available here).

The extension 6890 denotes all Agilent 6890 GC methods.

The extension asm denotes all Autosampler methods.

11. Choose Disabled, if you do not want to load any GC method.
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12. Look at the AS method by a click upon . The actual line will be 
activated and occurs in bold style (e.g. 1, i.e. Sample 1).

The column “AS Method” will be activated and occurs in bold style.

13. Choose between all autosampler methods you created before for the 
autosampler defined in your actual Configuration (e.g. 
“AS2000_1.asm” or “AS2000_2.asm” are available).

14. Choose Disabled, if you do not want to load any autosampler method.

15. Choose between Internal No 1 to Internal No 9 (i.e. internal method 
positions).

16. At Method, choose between all mass spectrometer methods you created 
before via New > Method button (e.g. “Method 1.met” or 
“Method 2.met” are available).
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Different locations of different methods
During Isodat 2.0 installation, different folders for storage of Isodat 2.0 
methods and GC/AS methods are created:

Isodat 2.0 methods are usually stored at a folder of their own, e.g. … \ 
FINNIGAN \ ISODAT NT \ Global \ User \ GC II-III Interface \ Method.

Autosampler methods are e.g. stored in a subfolder (e.g. “AS_Method”).

GC methods are e.g. stored in another subfolder (e.g. “GC_Method”).

AS / GC 
methods

ISODAT NT 
methods
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Chapter 2
Evaluation-related Features

This chapter contains the following topics:

• Standard Editor

• Ratio Editor
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2.1 Standard Editor
This section contains the following topics:

• Principle of the Standard Editor

• Opening the Standard Editor

• Creating a new Standard

• Choosing Standards during Method Creation

Principle of the Standard Editor
The Standard editor manages all working standards. It provides the system 
with information about the standards in use.

Choose among a lot of different molecules that can be used for 
standardization. Molecular standards can be managed and edited as well.

Opening the Standard Editor

1. Open the Acquisition mode .

2. Press  right to the Editors icon.

Note. When creating a method, at the Evaluation tab, a standard will be 
chosen from the Standard Editor’s list.
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3. Select Standard Editor.

The Standard editor will be loaded.
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Creating a new Standard

1. Press the New button .

2. At Name, type a significant name for the standard, e.g. “Haus 4”.

3. At Gas Name, type the formula of the gas the standard will be created for.
Alternatively, select the name from the pull-down menu.

4. Confirm by OK.

The new Standard will be included at the bottom of the list of standards 
defined. Its name, e.g. “Haus 4”, appears in the Name column.

The Gas column shows the gas to which it has been assigned (e.g. “CO2”).

In the Delta column, the respective deltas are displayed (e.g. “d 18O/16O” 
and “d 13C/12C”).

The Value column shows the value of the respective delta (default: 0.000).

The Primary Standards column allows to select a primary standard from the 
pull-down list (e.g. “VSMOW” or “VPDB”).
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Choosing Standards during Method Creation

1. Open the Acquisition Mode .

2. Press the New button .

3. Mark the Method icon.

Note. When creating a method, at the Evaluation tab, a standard will be 
chosen from the Standard Editor’s list!
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4. Confirm by OK and wait until the method is loaded.

5. Choose the Evaluation tab.

6. Click on  in the Ref. Name column.

Depending on the actual Gas Configuration, the pull-down menu offers 
the working standards that have previously been defined in the Standard 
Editor.
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7. Choose the working standard you want to use, e.g. “Haus2”.

The row will automatically be filled with the standard-related values from 
the Standard Editor. Thus, additional columns appear (if you type a 
reference time value into the Ref. Time column, this will happen as well).

8. If you manually change one of these values inserted from the Standard 
Editor (e.g. the d 13C/12C value from - 39.260 of the Standard Editor to 
- 39.000), the Standard Name changes to User Defined.
Other values in the row remain untouched.
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2.2 Ratio Editor
This section contains the following topics:

• Opening the Ratio Editor

• Adding an Evaluation to the Evaluations List

• Adding a Gas to the Filter List

• Information about Gases in the Filter List

• Incorporating a first Group of Ratios into the active Evaluation

• Incorporating a second Group of Ratios into the active Evaluation

• Incorporating an intermolecular Ratio into the active Evaluation

• Accessing Ratios in the Gas Configuration

Opening the Ratio Editor

1. Open the Acquisition mode .

2. Press  right to the Editors icon.

3. Select Evaluation Editor.
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The Ratio editor opens.
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Adding an Evaluation to the Evaluations List

1. At Current Evaluations, the predefined evaluations to be used for 
filtering are listed.

2. Via Add, add a new evaluation to the list.

3. Type the Name of the evaluation to be added (e.g. “Sulfur 4 masses”).

4. Confirm by OK.
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The new evaluation appears at the bottom of the list.

5. Via Remove, remove evaluations from the list.
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Adding a Gas to the Filter List

Take a look at the Filter list on the right:
If the gas to be used for ratio determination (e.g. “SO”) is missing there, it 
must be added to it as follows:

1. Press the Add button.

2. Type the gas name (e.g. “SO”) and confirm by OK.
If you type a non-existing element, an error message will occur.
The stoichiometry of the molecule will not be verified.

SO is missing in 
the Filter list.
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3. The gas (e.g. SO) has been added to the Filter list.

Information about Gases in the Filter List
Principle: To facilitate the choice of masses and ratios and to control its 

reasonability, Isodat 2.0 provides mass-, element- and 
abundance-related data of a wide variety of gases. Especially 
calculating quotients of abundance values may be helpful to 
avoid measurement difficulties e.g. to select suitable amplifiers.
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1. In the Filter list, mark the gas of interest (e.g. “SO2”).

2. Press the Info button.

3. The individual masses are displayed together with their abundances.
In addition, possible isotopic combinations leading to a particular mass 
are shown.

4. You can sort the columns “Mass” and “Abundance” in ascending or 
descending order by clicking on them (see the arrows above).

 

Thermo
ELECTRON CORPORATION2-14 ________________________Isodat 2.0 Operating Manual_________________________



Evaluation-related Features
Isodat 2.0________________________________________________________________________ Ratio Editor
Choose among three display options:

• Exact Mass: a mass will not be displayed as a rough mass, but 
“exactly”, i.e. showing six decimal places (e.g. 63.961900 instead of 
64).

• Compact List: if a bundle of species having the same mass occurs, 
only one of them will be displayed (e.g. 34S 18O 16O and 
34S 16O 18O, see above).
To activate this checkbox, the “Exact Mass” checkbox must be 
marked.

• Scientific Notation: an abundance will not be shown as a decimal 
number but using scientific notation.
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Incorporating a first Group of Ratios into the 
active Evaluation
Ratios from the different lists on the right can now be incorporated into the 
active evaluation.

Example: Incorporation of the SO ratios 50SO/48SO, 49SO/48SO into the 
evaluation “Sulfur 4 masses”

1. Note that the list “Ratios for Sulfur 4 masses” is empty, because no ratios 
have been incorporated yet.

2. Activate one particular evaluation by clicking on it (e.g. “Sulfur 4 
masses”).

The list does not 
contain any ratios.
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3. In the Filter list, click on the gas of interest (e.g. “SO”).
Note that “Sulfur 4 masses” turns into gray, i.e. it remains the active 
evaluation all the time.

4. The isotopical combinations available are now displayed in the 
Nominator and Divisor lists, respectively.

5. To determine a ratio made up by a nominator and a divisor, choose one at 
a time from both lists. Begin with e.g. 50SO/48SO as follows:

6. Mark the Nominator (e.g. 50SO).

7. Mark the Divisor (e.g. 48SO). The Nominator turns into gray,
i.e. it remains active.

8. Press the Add Ratio button (e.g. 50SO/48SO).

9. The ratio (e.g. 50SO/48SO) appears in the Ratios list.
It is now part of the evaluation “Sulfur 4 masses”.

10. Repeat the last steps for the second SO ratio (49SO/48SO).
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11. Both SO ratios appear in the Ratios list.
Both are now part of the evaluation “Sulfur 4 masses”.

Incorporating a second Group of Ratios into 
the active Evaluation
To measure SO2 ratios (e.g. 66SO2/64SO2) in parallel within the same 
evaluation “Sulfur 4 masses”, they must be added to the evaluation as follows:
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1. In the Filter list, mark SO2.
The associated molecular masses available will appear in the 
Nominator list and Divisor list, respectively.

2. Mark the Nominator (e.g. 66SO2).

3. Mark the Divisor (e.g. 64SO2). The Nominator turns into gray, i.e. it 
remains active.

4. Press the Add Ratio button (e.g. 66SO2/64SO2).

The ratio (e.g. 66SO2/64SO2) appears in the Ratios list.
It is now part of the evaluation “Sulfur 4 masses” as well.
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Incorporating an intermolecular Ratio into 
the active Evaluation
To measure intermolecular ratios (e.g. 64SO2/50SO) in parallel within the 
same evaluation “Sulfur 4 masses”, they must be added to the evaluation as 
follows:

1. In the Filter list, mark SO2.

2. Press the <Ctrl> key and mark SO simultaneously. Thereby, both gases 
will be marked. All associated molecular masses of both gases will 
appear in the Nominator list and the Divisor list, respectively.
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3. Mark the Nominator (e.g. 64SO2).

4. Mark the Divisor (e.g. 50SO). The Nominator turns into gray, i.e. it 
remains active.

5. Press the Add Ratio button (e.g. 64SO2/50SO).

6. The intermolecular ratio (e.g. 64SO2/50SO) appears in the Ratios list.
It is now part of the evaluation “Sulfur 4 masses” as well.

During the entire incorporation of ratios into an evaluation, the number of 
cups required is displayed together with the corresponding masses to be 
measured.

7. After all different ratios have been incorporated into the active evaluation,
finally press the Save button.
The Ratio editor will be closed. Your statements will be saved in the ratio 
database.
When the Ratio editor is opened again later, the evaluation “Sulfur 4 
masses” contains all ratios that have been incorporated previously (see 
topic Opening the Ratio Editor on page 2-8).
The Save command will overwrite older definitions of the evaluation.
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Accessing Ratios in the Gas Configuration
Principle: Evaluations must be anchored in a particular Gas Configuration. 

During measurement using the Gas Configuration, these 
evaluations will be executed.

The ratios that have been incorporated into an evaluation (see topics 
Incorporating a first Group of Ratios into the active Evaluation on 
page 2-16 to Incorporating an intermolecular Ratio into the active 
Evaluation on page 2-20) can now be accessed via the Gas Configuration 
editor as follows:

1. Open the Acquisition mode .

2. Press  right to the Editors icon.

3. Select Gas Configuration Editor.

The Gas Configuration Editor opens.
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In the Ratio Groups column, the ratio groups currently enabled for the 
actual Configuration are listed (e.g. ratio group “CO2” for the 
Configuration “CO2”). The ratio group database contains all ratio groups 
previously defined.

4. Click on the entry within the “Ratio Groups” cell of interest (e.g. on 
“CO2”).
The column header “Ratio Groups” thereby appears in bold style.
The color of the ratio group (i.e. CO2) changes from light green to white.

5. Again click on the entry.

6. The different evaluations that have previously been defined are listed (see 
topic Adding an Evaluation to the Evaluations List on page 2-10). As 
the evaluation “CO2” is currently enabled, it appeared in the “Ratio 
Groups” column above.
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7. To disable the evaluation “CO2”, click into the cell with the green hook.
The hook disappears and the cell is empty.

8. The evaluation “Sulfur 4 masses” is currently disabled. To enable it, click 
into the empty cell. A hook appears and “Sulfur 4 masses” is displayed in 
bold style.

9. Confirm by OK.
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10. As “Sulfur 4 masses” is the evaluation currently enabled, it will be shown 
in the “Ratio Groups” column.

As in the Evaluation Editor, the number of cups required is again 
displayed together with the masses to be measured. Isodat 2.0 compares 
these cup- and mass-related requirements to the statements you gave in 
the early beginning while configuring your mass spectrometer.

11. Type the masses being displayed into the appropriate cup columns
(i.e. assignment of the masses to the cups).

12. Finally, press Save & Close.
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It is possible to enable two or more evaluations in one and the same Gas 
Configuration simultaneously (e.g. evaluation “CO2” and evaluation “Sulfur 
4 masses”):

1. Enable both evaluations by clicking into the respective cells.

2. Confirm by OK.

Both evaluations appear in the “Ratio Groups” column.
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ELECTRON CORPORATION2-26 ________________________Isodat 2.0 Operating Manual_________________________



Evaluation-related Features
Isodat 2.0________________________________________________________________________ Ratio Editor
Again, the number of cups required is displayed together with the masses 
to be measured.
Note that the number of cups required may exceed the number of 
available ones (e.g. only 8 cups available whereas 10 are required).
Measurement will be impossible then, because Isodat 2.0 again compares 
these requirements to your statements during mass spectrometer 
configuration.

3. Type the masses being displayed into the appropriate cup columns (i.e. 
assignment of the masses to the cups).
During an evaluation, the ratio group will be analyzed according to the 
masses required. If masses cannot be found and thus not be measured, 
they will not be part of an evaluation. Ratios and all subsequent 
parameters will not be calculated.

4. Finally, press Save & Close.
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Chapter 3
Script-related Features

The three script-related features recently integrated or improved:

• ISODAT Script Language (ISL) and the ISL Editor

• Dynamic Variables Exchange (DVE)

• A powerful debugger

are closely interrelated and conceived as a package. Therefore, their separate 
description below might seem somehow artificial.
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3.1 ISL Editor
The script language ISL (ISODAT Script Language) itself and its commands 
have already been described in detail in the ISL-Online-Help. In this section, 
only the functions within the ISL Editor will be explained: emphasis is placed 
on how to edit ISL-Scripts and how to navigate through ISL.

Opening different Types of ISL Scripts

1. Open the Application Mode .

The “Application Mode” window opens.

2. Press the New button .

3. Mark ISL and confirm by OK.
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4. Choose a template for a script among the following six script types.

They are different only with respect to the libraries to be included.

• Script for Continuous Flow acquisition

All standard libraries required are included.

• Script for Dual Inlet acquisition

All standard libraries required are included.

• Script for external data processing

This type may be used for e.g. an ion correction.

• Library (without entry point)

This script type is used to create a library.

• Short script

Use this type to create short scripts that e.g. will run as subscripts.

Furthermore, scripts can be assigned to e.g. valves to induce a valve 
switch or to buttons (see Panel Design).

• Simple script

These scripts are used for different purposes.

5. Mark the script type of your choice (e.g. “Acquisition for Dual Inlet”).

6. Confirm by OK.

A script of the chosen type is opened. The ISL Editor appears. Its 
functions will now be described in detail.
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General Remarks concerning ISL Scripts

Variables and functions in ISL
In ISL, variables denote objects that can assume certain values. Functions are 
active components working with variables.

For detailed information about the difference between variables and functions 
and about particular ones, use context-sensitive ISL Help via <F1> as 
follows: position your cursor on an arbitrary string and press <F1>. The 
actual variable or function will be accessed and the corresponding help topic 
be opened.

Colors of keywords
Internal functions, i.e. ISL functions are highlighted by colors automatically:

• a blue function is an internal one denoting a control structure (e.g. a 
for-next loop).

• a lavender function also denotes an internal one (e.g. “set”).

• a green function has been commented out and has thus lost its meaning.

• a black function is part of the library and will be called up by “call”.

This is helpful for finding typing errors: if the text stays black, no internal 
function has been called, and the typo can easily be corrected. Afterwards, the 
corrected text is colored again.

Commenting out lines or blocks

• To comment out a single line, insert a double slash // where it begins. The 
line turns into green and loses its function.

• To comment out an entire block, insert /* where it begins. Do not miss to 
insert */ where it ends, because otherwise, the complete remainder of the 
script will turn into green and lose its function.
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Only the block turns into green and loses its function.

Finding out the content of variables
• Right-click somewhere into the script.

The context menu appears. It will be discussed in detail below.

Context Menu within the ISL Editor
The ISL Editor is an ordinary text editor. E.g. cut or paste content, drag & 
drop content, select a line or a block or indent a marked block via <Shift> 
key. Data will even be saved in *.txt-format.

Open File Command
To be able to take a look at a file that is mentioned in a script, position the 
cursor somewhere in the file name.

Example: To take a look at the file “Acquisition_lib.isl” position the cursor 
somewhere in this name. “Acquisition_lib.isl” is a typical library 
used to perform Dual Inlet Acquisitions. “Include” is a control 
structure to include a library.

 

1. Right-click on the file name (e.g. “Acquisition_lib.isl”).

2. Choose Open File.
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3. The file will be loaded in a window of its own (e.g. “Acquisition_lib.isl”).

Goto Definition Command
This command is meaningful, if you do not know the location where a 
particular function has been defined (not an internal function but a library 
function, e.g. “InitScript”). To call up such a function, position the cursor 
somewhere in the function name.

 

1. Right-click on the function (e.g. “InitScript”).
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2. Choose Goto Definition or press Edit > Goto Definition or <F11>.

The file is loaded. The function will be accessed and marked (e.g. 
“InitScript”). This is the definition of the library function.

Insert Function Command
Maybe, you do not know exactly the name of a particular internal function.

1. Position your cursor where you want to insert the internal function.
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2. Right-click on this position and choose Internal Function.
Alternative: Press <Shift> + <Ctrl> + <F> simultaneously.

3. A survey of the names of all internal functions is shown.

4. Increase or decrease the box by dragging its edges.

5. Find your internal function of interest by a right-click on the scroll-bar: 

6. Mark the internal function you are looking for (e.g. 
“_CalibrateAcidPump”).

7. Press Enter.
It will be inserted into the ISL Script at cursor position.

The box is closed (also by a double-click).

Insert Device Item (Cnf) Command
After you have thereby found the internal function, maybe you do not know 
the exact name of the peripheral it should act upon.

1. Set your cursor at the correct position.
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2. Upon a right-click select Insert Device Item (Cnf).
Alternative: Press <F6>.

A box opens that contains all peripherals of the actual configuration.

3. Increase or decrease the box by dragging its edges.

4. Find your peripheral of interest easily by a right-click on the scrollbar

5. Mark the peripheral you are looking for (e.g. “Change Over 2/Valve 34").

6. Press Enter. It will be inserted into the ISL Script at cursor position. The 
box is closed (also by a double-click).

Insert Device Item (All) Command
This command is meaningful when writing scripts for a configuration that is 
not the actual one at the moment.

• Upon a right-click select Insert Device Item (All).
Alternative: Press <Ctrl> + <F6> simultaneously (instead of <F6>). A 
box opens that contains all peripherals known in Isodat 2.0 (i.e. not 
filtered according to the actual configuration).
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Basic Functions - The ISL Toolbar
After you opened an ISL script (see topic Opening different Types of ISL 
Scripts on page 3-2), the ISL toolbar shown above offers a wide variety of 
commands.

They are helpful for handling ISL scripts and facilitate orientation within 
them. These commands will be discussed one by one below.

Undo and Redo Commands

• The Undo command reverses the last action or deletes the last entry you 
typed.

• The Redo command reverses the action of the Undo command (i.e. the 
Undo command must have been used immediately before).

Break and Control Break Commands
Breakpoints are used to check programs section by section with respect to 
bugs: if you know that a program works properly down to an unstable 
position, set a break point there to verify it.

1. Press Break  to set a breakpoint at the line of your cursor.
Alternative: Press Edit > Toggle Breakpoint or <F9>. A red point 
appears at the left edge of the ISL Script.

2. Then, press the Debug button  to start the script in Debug 
Mode (used for stepwise execution of a script in order to debug it). As 
always, debugging starts at the entry address of the program (“main”) and 
stops at the break point that just now has been set.
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3. Break is a toggle command: press it twice to remove the break point 
again.
Alternatives: Press Edit > Toggle Breakpoint twice or <F9> twice.

4. Press Clr Break  to eliminate all break points. Remember 
that pressing Break twice will only remove the single break point of the 
actual line.
Alternative: Press Edit > Remove all Breakpoints to eliminate all 
break points.

Run and Debug Commands

1. You are reminded to save the ISL Script prior to choose either Run or 
Debug. Confirm by Yes.

2. Select an appropriate folder.

3. Type a significant file name (e.g. “Execution.isl”).

4. Confirm by Save.
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Note the difference between Run and Debug:

Run Breakpoints will not be considered (i.e. the execution of the script 
overrides break points without stopping).

Debug Breakpoints will be considered (i.e. the execution of the script 
stops at break points).

5. Press Run  to simply start a script from the beginning until it 
reaches its end without debugging it. In contrast to Debug, breakpoints 
will not be considered. This is used to check whether a script is working 
properly or not.
Alternatives: Press Script > Go or <Ctrl> + <F5>.

6. Press Debug  to start a script in Debug Mode i.e. breakpoints 
will be considered. Debugging without breakpoints is meaningless.
Alternatives: Press Script > Debug or <F5>.

Press the Options  button. Then mark Debug.
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ELECTRON CORPORATION3-12 ________________________Isodat 2.0 Operating Manual_________________________



Script-related Features
Isodat 2.0_________________________________________________________________________ ISL Editor
Note that Debug Mode is indicated by a yellow background whereas the 
ISL Editor's background is white.

Stop and Break Commands

• Press Stop  to stop a script that is being executed(i.e. it is 
running or being debugged).
Alternatives: Press Script > Stop or <Alt> + <F5>.

A red X appears at the left edge of the script.

The last error message that occurred at X is displayed at Info (e.g. “A normal 
error occurred: Script terminated by user”).

The error message is also displayed at the Status bar at the bottom right.
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• Press Break  to pause a running script at its current position 
(e.g. long-lasting processes or unintended endless loops are being 
executed).

• The yellow program counter together with a yellow line reveal the 
position (e.g. an unintended endless loop or a deadlock, i.e. two processes 
waiting for each other. These bugs can be corrected in this way).

Step in, Step over and Step out Commands
Note the difference between Step over and Step in:

Step over: Select a new function or execute it without leaving the actual 
context. Other contexts are irrelevant at the moment.

Step in: Select a new function or execute it and leave the actual 
context. The context of this new function one level deeper is 
entered in order to take a look at it.

Example: Consider the two functions “InitScript ()” and “CleanUp ()” 
in an arbitrary ISL Script. Below, they are both marked red.

1. Position your cursor in the line “call InitScript ()” (within main() context).

2. Press Break in order to set a breakpoint there. The breakpoint appears at 
the left edge.
Thermo
ELECTRON CORPORATION3-14 ________________________Isodat 2.0 Operating Manual_________________________



Script-related Features
Isodat 2.0_________________________________________________________________________ ISL Editor
3. Press Debug. Thereby, one changes to the Debug Mode (yellow).

Note that debugging stops at the break point (within the main context). 
The yellow program counter now points to the line and has replaced the 
break point.

Case I: “Step over” command

a. Press Step over .
Alternatives: Press Script > Step over or <F10>.

The program counter has executed the function “InitScript ()” and stepped 
over it. It is now positioned in the line below the function.

Note that the context is still the same (i.e. context “main ()”). Therefore, 
contents of any other context (e.g. context “InitScript ()”) are 
unimportant. The break point is visible again.
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Case II: “Step in” command

a. Press Step in .
Alternatives: Press Script > Step into or <F8>.

Note that the program counter has left the original context and is now 
positioned on another function (“CleanUp”) within another context. This 
new context can thus be examined. The break point is visible again.

Step out  is used to terminate all processes within the actual 
context and to leave it (e.g. after debugging has been successful in 
“CleanUp” context). One moves to the next higher context (e.g. to “main” 
context).
Alternatives: Press Script > Step out or <Shift> + <F7>.

This command is advantageous, if in an old context a lot of functionality 
is active that is no longer important: simply press Step out to terminate 
this.

 

Step out
Thermo
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Pressing Step out  repeatedly will finally lead back to the 
ISL Editor. The break point is visible again. Step out is only available in 
Debug Mode.

Prg Ptr Command
The program pointer indicates the position of the program within the 
script.The Prg Ptr command is useful when scrolling through long scripts: if 

you do not know the actual position of the program pointer  anymore, press 

the Prg Ptr button . The cursor will instantaneously move to the 
program pointer. This command is only active in Debug Mode i.e. not in the 
ISL Editor itself.

Watch Command and Debug Bar

The Watch command  can be toggled and serves to switch on and 
off the Debug bar. Switch it off occasionally in case of long lines. The Debug 
bar is organized by four tabs: Variables, Functions, Call Stack, and Threads. 
Drag&drop it to move it around. The Debug bar is activated automatically 
when entering debug mode (by pressing “Debug” or “Step in”). In ISL Editor, 
the Variables tab leads to an empty list.

Step out
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At Variables tab, the names and actual values of the variables that occur in the 
script are listed. A small colored block left to the name denotes the type of the 
variable. E.g. a blue block denotes a string variable whereas a red block 
symbolizes a pointer variable.

Example: The variable named “Idle” is a pointer variable (red block). Its 
actual value is 15000.
Various types of variables are represented differently. E.g. a 
boolean variable may be represented by the value 0, i.e. false, 
whereas a string variable may be represented by the numeric 
value 15.
If you define new variables in the script and enter debug mode, 
they will occur in the list at Variables tab. If a variable changes its 
value, the new one will be displayed there.
At “Script Name”, the name of the script always occurs.
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At Functions tab, the names of the functions defined in the different scripts 
are listed in the Name column. At the Location column, find the particular 
ISL Script, where it is defined. E.g. The function “Pressureadjust” occurs in 

the script “Acquisition_lib.isl”. All functions have the same symbol  
shown left to the Name column.

At Call Stack tab, the order of functions that have been called up recently is 
displayed. The function called up at last lies on top of the stack (i.e. the actual 
context). It is possible to represent even complex branchings of functions 
involved. This serves as a map showing the stages covered on your way when 
springing between different functions.

Example: If you started at context “main”, stepped over to function 
“InitScript “and finally stepped over to function “CleanUp”, the 
stack shown above results.

ISL allows you to start several processes. After starting the main process you 
can start another one. Threads are processes that run “independently” of the 
main process performing tasks asynchronously. The “independence” is not an 
absolute one, because usually the main process controls its subordinate 
processes terminating them in due time.
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Stick Command

The Stick button  is available in any Isodat 2.0 document, not only in 
ISL documents. It can be toggled.

• If you have opened a file - e.g. an ISL Script - and press the Stick button, 
it will be “pinned” there staying opened even if you open further ones 
(e.g. via File Browser).

• However, if you have opened a file - e.g. an ISL Script - with Stick being 
deactivated and you open another ISL Script of the same type, the former 
will be closed.

Additional Commands - The Menu Bar
The Menu Bar refers to the document that is currently open.

Find and Replace Commands

1. To find particular content within the script currently active, press 
Edit > Find… or <Ctrl> + <F>.
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a. Type the content you are looking for (e.g. “script”). If your cursor is 
positioned at a string, the string will appear in the Find what field.

b. Mark Match case to distinguish between upper case and lower case 
letters (e.g. find “script” but not “Script”).

c. Mark Match whole word only to find only the exact term but no 
composite forms (e.g. “Author” but not “Authoring”).

d. Specify the search direction (i.e. “up” or “down”).

e. Finally, confirm by Find Next.
If found, the term will be highlighted. If the term does not occur in the 
script, an error box appears.

2. To continue your search, press Edit > Find… or <Ctrl> + <F> again.

1. To replace particular content within the script currently active, press 
Edit > Replace… or <Ctrl> + <H>.
________________________ Isodat 2.0 Operating Manual _________________ 3-21Thermo
ELECTRON CORPORATION



Script-related Features
ISL Editor____________________________________________________________________ Isodat 2.0
a. Type the string to be found (e.g. “Author”) and the one that will 
replace it(e.g. “Writer”). If your cursor is positioned at a string, the 
string will appear in the Find what field.

b. Mark Selection to replace within selected text or Whole file to 
replace within the entire file (default).

2. Press Find Next to find the next match without replacement.

3. Press Replace to replace only the first match.

4. Press Replace All to replace all matches.

Set Bookmark and Clear Bookmark Commands

Bookmarks are especially useful in case of long scripts. They facilitate 
orientation and allow to move quickly within a script. Set as many bookmarks 
as you like. E.g. set a bookmark at a particular line. Then move to another 
position where you want to read something. After reading, press <F2> to 
return to the bookmark.

In case of several bookmarks, <F2> will lead to the next one. After the last 
bookmark has been found in a script, <F2> will lead to the first one in the 
script.

1. To set a bookmark at a particular line within the active script, press 
<Ctrl> + <F2>. A turquoise point appears at the left edge of the line.

2. Another <Ctrl> + <F2>, clears the single bookmark. The turquoise point 
disappears.
Thermo
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3. To clear all bookmarks press Edit > Clear Bookmarks or 
<Ctrl> + <Shift> + <F2>. All turquoise points disappear.

Save Dynamic Externals Command
Principle: An external parameter set for the dynamic externals is written 

into a file (*.iso file) and saved together with a script. The 
external parameter set can thus be used beyond the script. E.g. a 
hardware can access it later on.

Remember that dynamic externals can be created also for 
hardware parameters. When the corresponding hardware is 
loaded, the information will not be loaded from the script itself 
but from the external parameter set.

• Click Dynamics > Save Dynamic Externals.
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Information Bar in an ISL Script
Principle: The Information bar shows detailed information on the various 

types of errors that might have occurred. If an error has been 
detected during debugging a script, the corresponding error 
message reveals the line, which additionally is marked by a red X 
in the script (see topic Run and Debug Commands on 
page 3-11).

Moving the bar and changing its dimensions
As with every application of Isodat 2.0, the Information bar is also present at 
any ISL Script. Although usually located at the bottom, it can be easily moved 
to other places within the “Dual Inlet” window by clicking at its left edge and 
dragging your mouse.

You can change its vertical dimension by clicking at its upper edge and 
dragging your mouse. After you moved it to another place, you can also 
modify its horizontal dimension.

Showing and hiding the bar
1. To show or hide the Information bar, press the Options 

button .
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2. Mark or clear the Information checkbox.

3. Confirm by OK.
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3.2 Dynamic Variables Exchange 
(DVE)

Principle: DVE allows to perform dynamic data exchange between methods 
and a script.

Dynamic variables can easily be generated in a method.

Write tailored scripts totally on your own and parameterize them 
via a method.

External variables are fixed variables that are sought and exchanged by a 
method. They have a distinct name beginning with “external”.

Example: The external variable “Dual Inlet Idle” is an idle time between 
two measuring points. It is controlled by a method.

1. Open a Dual Inlet method. At Peripherals tab page, the parameter “Idle 
time” occurs. Its actual value is 15 s. The appearance, position, and value 
on this particular tab page is defined in an ISL script.

Note that the ISL Script tab page is still empty.
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2. Use the Toggle MDI button to switch between a method and an ISL 
script.
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Chapter 4
Reporting-related Features

This chapter contains the following topics:

• ResultWorkshop
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4.1 ResultWorkshop
This section contians the following topics:

• Principle of the ResultWorkshop

• Multidimensionality

• Opening the ResultWorkshop

• Printout Templates

• Toolbars

• Inserting Objects into the Working Grid

• Changing the Properties of Objects

Principle of the ResultWorkshop
The ResultWorkshop allows to arrange objects to display a variety of data on 
a printout, e.g. ratio traces, GC traces. It is possible to print components of 
any file that has once been generated by Isodat 2.0, e.g. method files, 
sequence files, result files. A broad diversity of objects can be tailored before 
they are printed. The approach of the ResultWorkshop is a generic one, i.e. 
the objects bring along their own print routines.

A result file that contains the data for the objects to be filled with during 
editing must be available. The result files (e.g. *.cf, *.caf) available for 
selection are listed in the result file browser.

Two primary features of Isodat 2.0's ResultWorkshop are

• Multidimensionality (see topic Multidimensionality on page 4-2)

• Self-Actualization (see topic Opening a predefined Printout Template 
on page 4-5)

Multidimensionality
One of Isodat 2.0's outstanding properties is multidimensionality: One single 
ResultWorkshop template can store layout information for all gas types, i.e. 
for all ratio groups. For each gas, a specific layout of its own will be saved (no 
matter how many gases are to be measured).

To setup this template also for another gas type, select a corresponding 
Acquisition file (e.g. *.cf, *.caf) from the File Browser. Modify objects 
according to your needs, save and use the same ResultWorkshop template 
filename in all of your methods.
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Example: After measuring CO2 and recording of CO2-specific data, you 
may want to measure N2. Thus, if you select a N2-result file, it is 
possible to adjust completely new parameters, which are 
N2-specific, using the same ResultWorkshop template. This can 
be generalized, i.e. extended to an arbitrary number of gases.

Opening the ResultWorkshop

1. Start Isodat 2.0 by a double-click on the  icon.

2. Double-click the ResultWorkshop icon .

The ResultWorkshop opens, showing the empty working area on the right.

On the left, see the Accessories Toolbar.

empty working area

Accessories toolbar
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Accessories Toolbar

The Accessories toolbar shown above contains the Object Properties box and 
the File Browser. Note that the Object Options tab at the Object Properties 
box is currently empty and the File Browser currently offers only two tabs, 
“RW2000 Files” and “Search”.

Switching between objects

The Object Properties box reveals various properties of the object that is 
currently selected. If another object is selected, its properties will be displayed 
instead. If no object is selected at all, the “Object Properties” box contains no 
properties.

• To deselect an object, click somewhere onto the working grid but outside 
of any objects.

Properties of selected object
No properties are shown after 
deselecting the object
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ELECTRON CORPORATION4-4 _________________________Isodat 2.0 Operating Manual_________________________



Reporting-related Features
Isodat 2.0____________________________________________________________________ ResultWorkshop
Showing / Hiding the “Accessories” toolbar
• To show/hide the “Accessories” toolbar, press the Options 

button .

• To show the “Accessories” toolbar, mark the Accessories checkbox.

• To hide it, unmark the Accessories checkbox.

Printout Templates

Opening a predefined Printout Template
In addition to create and edit new printout templates (see topics Creating a 
new Printout Template on page 4-10 and Creating more than one new 
Printout Template on page 4-11), the ResultWorkshop allows to access a 
variety of predefined printout templates, i.e. working grids filled with 
measurement-related data.

1. Press the Open button .
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2. Select your ResultWorkshop printout template (*.irw).

Alternative: Select the printout template (*.irw), e.g. “Default 
Result.irw”, from the File Browser's RW2000 Files tab.

Double-click or drag&drop it onto the working area.
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The printout template will be shown as working grid in the 
ResultWorkshop's main window. It has not been filled with 
measurement-related data yet.

The browser displays folders that contain result files for the active 
configuration.

3. Click through the folders to find your result file (*.cf, *.caf).

4. Finally, just mark the result file.
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The result file is used as a data source: its measurement-related data fill the 
objects of the printout template immediately.

Self-actualization of data throughout different templates

1. Move to another result file. E.g. move from “Acquisition-1.caf” to 
“Acquisition-10.caf” as is shown above.
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The data of the old result file will immediately be replaced by the 
corresponding data of the actual one. This is called self-actualization of 
data.
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Creating a new Printout Template

• Press the New button .

Note that the File Browser now offers four tabs: “RW2000 Files”, 
“Search”, “Browser” and “Isodat Results”. Its color has turned into 
yellow.

An empty working grid appears and fills the working area. Its default 
name is Isodat Result Workshop1.
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Creating more than one new Printout Template
It is possible to open several working grids or printout templates in parallel. 
You can easily work with them side by side and switch between them.

1. After opening your first working grid (see topic Opening a predefined 

Printout Template on page 4-5), press the New button  
repeatedly.

Additional working grids are opening having the same dimensions. Their 
default names are is Isodat Result Workshop2, Isodat Result Workshop3, 
Isodat Result Workshop4 etc. Each time, the number behind “Isodat Result 
Workshop” is augmented by one. Clicking on a particular working grid will 
move it into the foreground. You can selectively close one or more grids.
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2. Press the  arrow next to the Toggle MDI button.

3. Choose between three modes of grid arrangement (Cascade, Tile 
vertical, Tile horizontal) or close all grids by Close all.

4. In order to move a particular grid to the foreground, click on its name 
(e.g. “Isodat Result Workshop 1"). It will be marked in the pull-down 
menu.
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Editing a Printout Template
After opening a predefined printout template (see Opening a predefined 
Printout Template on page 4-5) or creating a new one (see Creating a new 
Printout Template on page 4-10 and Creating more than one new Printout 
Template on page 4-11), they can be edited, i.e. modified as:

1. Open the printout template to be edited (i.e. modified, see topic Opening 
a predefined Printout Template on page 4-5).

2. Click the  icon to select a new object.

3. Define its dimensions and position on the working grid by dragging your 
mouse.
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The new object has been inserted.

Changing the object type
After an object has been inserted, its type can be changed via the Accessories 
toolbar (see Accessories Toolbar on page 4-4).

The object on the working grid is shown above on the right. See its 
description on the left:

Object: Error Data

Type: Grid - Error
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• Select another type from the Type pull-down menu (e.g. “Grid - 
Evaluated Data”).

A new object appears at the same position replacing the old one.

Object: Evaluated <CO2>

Type: Grid - Evaluated Data

Edit Mode

1. A double-click on an object switches it to the Edit Mode:

2. Content and layout properties can now be changed by a right-click. The 
popup menu shown above appears.
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3. Use Columns to add or remove columns that contain object information.

4. Activate the checkboxes, if you want to see them as columns of the grid 
object. If a checkbox is deactivated, the column will not be visible in the 
grid object.

5. Use Fit Cells to Grid  to let the columns 
optimally span the available grid space.

6. Use Fit Cells to Text  to adjust all column widths 
to the required space of text or numbers they contain.
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Saving a Printout Template
After having finished the design of the printout template, it can be saved as 
follows:

1. Press File > Save As….

2. The ResultWorkshop file will be saved in a ResultWorkshop folder 
displayed on top of the box. Accept it or choose another one.

3. Type a significant name and accept the extension .irw (i.e. ISODAT NT 
Result Workshop Version 3 file).

4. Confirm by Save.

grid to be saved (partly shown)
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Loading a Printout Template
Load a predefined or self-made printout template as follows:

1. Press the Open button .

2. Select a file and confirm by Open. The working grid appears.
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Toolbars
Several toolbars surround the working grid. Show or hide them selectively:

1. Press the Options button  at the Basic toolbar.

Basic toolbar

Horizontal 
Ruler bar

Object toolbar

Page toolbar

Vertical 
Ruler bar

Status bar
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2. Mark or unmark the checkboxes to selectively show or hide individual 
bars.

Basic Toolbar

Stick command

The Stick button  is available in any Isodat 2.0 document, not only 
in ResultWorkshop printout templates. It can be toggled.

• If you have opened a printout template and press the Stick button, it will 
be “pinned” there staying opened even if you open further ones.

• However, if you have opened a printout template with Stick being 
deactivated and you open another one, the former will be closed.
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Undo and Redo commands

• The Undo command reverses the last action or deletes the last entry you 
typed.

• The Redo command reverses the action of the Undo command (i.e. the 
Undo command must have been used immediately before).

Options command

• On the Basic toolbar (i.e. right to the Redo button), press the Options 
button. Do not mix it up with the Options button on the “Basic” bar!

The Bars and Global tabs have been described in the topic Page Toolbar on 
page 4-22.
________________________ Isodat 2.0 Operating Manual _________________ 4-21Thermo
ELECTRON CORPORATION



Reporting-related Features
ResultWorkshop_______________________________________________________________ Isodat 2.0
Status Bar

The Status bar beneath the grid reveals information about: the page you are 
currently working on:

• the format of the actual page.

• the number of objects located on the working grid.

• the magnification of the current page (Zoom, default = 1.0, i.e. original 
size).

A grid may stretch across several pages. The number of the current page is 
indicated at the Status bar (default: current page: 1).

The default format of the working grid is 190 mm × 271 mm.

1. In order to change its dimensions move to the margin of interest. The 
image shown on the left appears.

2. Keep the <Ctrl> key pressed. The image changes to the one shown right.

3. Drag the margin to its intended new place.The grid's new dimensions will 
be shown at the Status bar.

Page Toolbar

Print Preview

• Press the Print Preview icon  to display the entire page as it looks 
if it were printed.

a working grid can span 
more than one page

<Ctrl>
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It is possible to zoom in or out the entire page.

Navigating through the working grid

• Use the Previous Page  and Next Page  buttons to navigate 
across a grid that spans more than one page.
Even in case of a grid that is empty or that spans only one page, both 
buttons are active: Next Page will show empty grid pages then.

Zoom commands

• Use the Zoom in  and Zoom out  buttons to gradually 
change the magnification of the grid (± 10% per click).The actual zoom 
factor is displayed beneath it.

• The Zoom 100%  button restores the original zoom factor (i.e. 1.0).

Deleting objects
1. Select the object(s) to be deleted.

2. Press the Delete icon . The object(s) will disappear from the 
working grid.
Alternative: Use the Delete command on the context menu (see Context 
Menu on page 4-47).
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View object info tree
The object info tree quickly provides information about the various objects on 
the working grid.

1. Select one or more objects (e.g. above).

2. Press the View Object Info Tree button .

The objects on the working grid are listed together with their individual 
properties (e.g. three text objects, their coordinates, shapes and filling types).
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Merge and append objects from file
It is not necessary to generate objects anew after you once created them. 
Rather, a broad variety of objects can be imported into the actual 
ResultWorkshop document (.irw) from other files.

1. Click on the position within your actual grid where you want the objects 
of another file to be appended.

2. Press the Merge and append objects from file button .

3. From the Files of type pull-down menu, select the file type to be 
appended.

4. Select the file to be appended and confirm by Open.

Note. Not only Isodat Result Workshop files (*.irw) can be appended, but 
also Isodat Scans (*.scn) and Isodat Calibrations (*.cal).
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5. The new file that contains objects of its own, has been appended to the 
active working grid. Therefore, the Status bar reveals the total number of 
objects (see Status Bar on page 4-22).

Adjust objects relative to the selected object
The ResultWorkshop offers five commands to adjust other objects relative to 
a selected object. Usage of these commands requires at least two objects on a 
working grid, one of them being currently selected (“Main”) and the other one 
(“Sub”) to be adjusted relative to the “Main”. The object(s) to be adjusted 
may not be locked, see topic Context Menu on page 4-47.

1. Define a “Master” object and a “Sub” object.

2. Select the “Master”. Thereby, the “Master” will be enclosed by its box.

3. Keep the <Ctrl> key pressed and click on the “Sub”. Both objects will be 
enclosed by one common box. This indicates, that they now belong 
together. The “Sub” can now be adjusted relative to the “Master” in 
different ways as follows.

<Ctrl>
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• Use the Adjust down button  to arrange the “Sub” at the 
bottom of the common box.

• Use the Adjust up button  to arrange the “Sub” on top of the 
common box.

• Use the Adjust left button  to arrange the “Sub” at the left edge 
of the common box.
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• Use the Adjust right button  to arrange the “Sub” at the right 
edge of the common box.

• Use the Adjust size button  to conform the size of the “Sub” to 
that predefined by the “Master”.

Furthermore, it is possible to adjust more than one “Sub” to a “Master”.

1. Select the “Master”.

2. Keep the <Ctrl> key pressed while selecting the “Subs”.

3. Click the Align command of interest.

Adjust objects relative to the page margins
The following three commands serve to adjust objects relative to the page 
margins.
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ELECTRON CORPORATION4-28 ________________________Isodat 2.0 Operating Manual_________________________



Reporting-related Features
Isodat 2.0____________________________________________________________________ ResultWorkshop
1. Select the object(s) to be adjusted.

2. Press the  button. The selected object will be stretched and spans the 
entire page width.

1. Select the object(s) to be adjusted.

2. Press the  button. The selected object will be stretched and spans the 
left half of the page. The right half of the page remains untouched, e.g. 
stays empty.

1. Select the object(s) to be adjusted.

2. Press the  button. The selected object will be stretched and spans the 
right half of the page. The left half of the page remains untouched, e.g. 
stays empty.
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If objects are locked, they can not be adjusted, see topic Context Menu on 
page 4-47. You can adjust an (unlocked) object while another locked object is 
placed within the stretching area. It will be stretched in the background, 
whereas the locked object remains untouched in the foreground.

After selecting an object, you can switch between the three different 
stretching modes, e.g. first stretch an object to the left half of the page. Then 
simply click the respective button to stretch it to the right half of the page.

Switch on/off the guiding lines

• Press the  button to let the guiding lines of the working grid appear 
or disappear (toggle command).

Changing the appearance of the guiding lines

1. On the Basic toolbar, press the Options button  (see topic 
Basic Toolbar on page 4-20).

2. Select the Global tab.
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3. At Distance regulate the distance between two guiding lines (in mm): 

either type in an integer value between 1 and 10 or use .

4. If you mark the Adjust objects on grid checkbox, the guidelines can be 

shown and hidden via the toggle command . If the checkbox is 
unmarked, the toggle command is inactive and the guidelines are not 
visible.

5. At Head Line and Feed Line, mark the Enable checkbox to insert a 
header/footer into the working grid. If the checkbox is unmarked, no 
header/footer will be inserted.

6. At Head Line and Feed Line, mark the View Page Number checkbox to 
insert a page number into the header/footer. If it is unmarked, no page 
number will be inserted. The Enable and View Page Number checkboxes 
can be used independently: a page number can be displayed without a 
header or footer. A header or footer can be displayed showing no content.
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Object Toolbar

Arrow icon

• Press the Arrow icon  to perform a lot of actions on the working 
grid.

Insert Acquisition Time
It is possible to insert the time of data acquisition into the working grid.

1. Press the Acquisition Time icon . The mouse pointer turns into a 
crosshair cursor.

2. Click on the position within the working grid, where you want the new 
box to appear.

3. Drag the crosshair cursor until the final size of the box is reached.

4. The box may contain different texts (e.g. “1. Date”).
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5. From the Type pull-down menu, choose between various entries (default: 
Date, which leads to the text “1. Date” within the box).

E.g. Choosing Gas Configuration leads to the text “1. Gas Configuration” 
within the box, etc.

6. The actual size of the box is displayed below (in mm). When the size is 
changed via the sizing handles at its edge, these modifications will also be 
displayed.

Insert Isodat Object
• To insert various Isodat objects into the working grid, press the ISO icon 

.
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Insert Result File Name
• To insert the name of a Result File into the working grid, press the 

Result File Name icon .

Insert Text File
• To insert an entire text file into the working grid, press the Text File icon 

. However, to insert text, use the Text icon .

Insert Text

• To insert text into the working grid, press the Text icon  (see 
Inserting a Text Object on page 4-42). However, to insert an entire text 

file, use the Insert Text File icon  described above.

Insert Grid

1. To insert a grid into the actual working grid, press the Grid icon . 
The mouse pointer turns into a crosshair cursor.

2. Click on the position within the working grid, where you want the new 
grid to appear.

3. Drag the crosshair cursor to generate the grid, i.e. a table (default: 5 rows 
and 5 columns).

4. To increase the size of the box that contains the grid drag its sizing 
handles. The box should enclose the grid. 
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Alternative: Mark the Autosize checkbox. The box will automatically 
enclose the grid. It is impossible then to modify the box 
dimensions by dragging the sizing handles.

5. Mark the Hide checkbox to hide the lines within the new grid (i.e. table).

6. At Colors, select a fill color for the new grid.

7. At Size, the dimensions of the box enclosing the grid is displayed.

8. Mark the Autosize checkbox to let the grid be enclosed by the box.

9. A double-click on the new grid leads to the design shown right.

10. If you marked the Hide checkbox before, the double-click leads to the 
design shown right, i.e. the lines are hidden.
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11. A further click on the grid allows values to be typed into its cells.

12. Finally, click on the surrounding working grid.

Insert a simple object
1. To insert a simple object, i.e. without text, into the actual working grid, 

press the Simple icon . The mouse pointer turns into a crosshair 
cursor.

2. Click on the position within the working grid, where you want the simple 
object to appear.

3. Drag the crosshair cursor to generate the simple object.
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4. Click on the working grid to see the simple object just inserted.

5. At Type, choose between a variety of geometric shapes to be displayed 
(default: rectangle).

6. At Line, define the thickness of the surrounding line between 0.1 mm and 
10 mm. “Hair” is even thinner than 0.1 mm.

7. Mark the Filled checkbox to fill the geometric shape with a fill color 
defined below. If it is unmarked, the shape will not be filled at all.
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8. Select a Fill Color to fill the geometric shape with. Additionally, select a 
Line Color for the line limiting the shape outwards.

9. At Size, define the dimensions of the geometric shape. If you modify its 
dimensions by dragging the sizing handles, these changes will be 
displayed there.

Insert a Graphic

1. To insert a graphic into the working grid, press the Bitmap icon . 
The mouse pointer turns into a crosshair cursor.

2. Click on the working grid, where you want the graphic to appear.

3. Drag the crosshair cursor to generate the box that encloses the graphic. 
The default graphic shown above appears.
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4. Press the  symbol to search another graphic to be displayed instead.
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Usually, bitmaps related to Isodat 2.0 are stored in a folder of their 
own,e.g. Finnigan\ISODAT NT\Global\Databases\Bitmaps.

5. Select the bitmap (*.bmp) to be displayed instead of the default graphic.

6. Confirm by Open.

The bitmap appears on the working grid and its name is displayed in the 

entry field: 

7. The graphic is shown above the Shade checkbox.

8. Mark the Shade checkbox to assign a shade color to the graphic. The 
shade color will be defined below.

Note. Only bitmap files (*.bmp) are supported.
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9. Press the  button to turn a highly asymmetric graphic into a regular 
one.

10. Mark the Round checkbox to erase graphic text that is located outside the 
contours of the graphic. Some rectangular graphics will be displayed with 
oblate rounded edges.

11. At Colors, select a shade color.

12. At Size, define the dimensions of the graphic. If you modify its 
dimensions by dragging the sizing handles, these changes will be 
displayed there.

Note. At Size, the dimensions will change to X2 = Y2.

Note. The Shade checkbox must be marked for the shade color totake effect.
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Inserting Objects into the Working Grid
Via simple drag&drop, various types of objects can be placed onto the 
working grid, e.g. text objects, graphical objects.

Inserting a Text Object
1. To place a text object (i.e. a text box) onto the working grid, press the 

Text Object icon  on the Object toolbar.

2. When you move your mouse pointer towards the working grid, it turns to 
a cross-hair cursor.

3. Keep the left mouse button pressed and drag the cross-hair cursor.

4. Release the left mouse button. A text object appears on the working grid.

Note that on the Status bar, the number of objects in the working grid has 
increased from 0 to 1.

5. Adjust the dimensions of the text object by dragging its sizing handles.

6. To adjust its position left-click into the box and keep the left mouse 
button pressed. Move the text object to its intended position. Finally, 
release the left mouse button.

7. To assign a significant text to the text object double-click into it. The text 
object turns into yellow and the text becomes editable.

8. Type a significant text and click somewhere outside the box.
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Changing the Properties of Objects
After inserting an object onto the working grid (e.g. a text object, see topic 
Inserting Objects into the Working Grid on page 4-42), you can change its 
properties using the Object Properties box at the “Accessories” toolbar.

As long as an object is selected (e.g. a text object), Object Properties shows 
its actual properties:

The properties are arranged in groups: font-, type-, colors- and size-related 
ones.

• Use the  buttons to selectively mask particular groups of information.
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Changing Font Properties

1. Choose a font from the list above (default: Arial).

2. Choose a font size between 0 points and 127 points from the list below 
(default: 10 points).

3. Choose a value in º between 0 and 360 to rotate the text within the object 
(default: 0º, i.e. no rotation).

4. To choose a horizontal offset (h) in mm between 0 and 1000, 
double-click into the upper entry field and type a value. Alternatively, use 

 to increase or decrease the value. Using  in the right corner of the 

entry field will only increase the value, while  in the left corner of the 
entry field will only decrease it.

The text will be moved horizontally within the object. The default is 0, i.e. 
the text appears at the left edge of the object. When the offset exceeds the 
object dimensions, the text is moved outside the object and can not be 
seen.

5. To choose a vertical offset (v) in mm between 0 and 1000, analogously 
use the lower entry field.

6. The text will be moved vertically within the object. The default is 0, i.e. 
the text appears at the upper edge of the object. When the offset exceeds 
the object dimensions, the text is moved outside the object and can not be 
seen.

Note. When the Center checkbox is marked, rotation and offset changes will 
not take effect. Instead, the text will always stay centered. You must unmark 
this checkbox for the rotation and offset values to take effect.

h
v
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Changing Type Properties

1. From the pull-down menu, select a geometric structure to be placed into 
the object (e.g. a circle). As default, “Nothing” is proposed, i.e. the object 
is displayed without a geometric structure incorporated.

2. From the Line pull-down menu, select a value between 0.1 mm and 
10 mm for the thickness of the geometric structure's lines. The default 
value “Hair” is even thinner than 0.1 mm.

3. Mark the Filled checkbox to fill an enclosed geometric structure with a 
fill color. Black is proposed as default fill color. Geometric structures 
without enclosure, e.g. lines, can not be filled.

Changing Color Properties

1. Press the  arrow.
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2. Choose between fill color, line color and text color. Black is the default 
color for any of the three types.

3. Clicking on each line opens a collection of basic and custom colors. Make 
your choice and confirm by OK.

• A fill color can be used in case of enclosed geometric structures (e.g. 
a circle). Geometric structures without enclosure, e.g. lines, cannot be 
filled, i.e. any fill color will have no effect.

• A line color can be used for any geometric structure.

• A text color can be used for any text.

Example for fill, line and text colors

Changing Size Properties

It is possible to change the dimensions of the chosen object by typing the 
intended values in the entry fields.
If you, on the contrary, drag an object's size handles, the values in the entry 
fields will be modified.
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Context Menu
The properties of inserted objects can alternatively be changed as follows:

1. Select an object.

2. Press the right mouse button.The context menu appears.

Properties Command

• Select Properties. The Accessories toolbar appears. Usually this toolbar 
is displayed left to the working grid and shown or hidden via 
Option > Accessories (see topic Accessories Toolbar on page 4-4).

Copy and Paste Commands
Use these commands to duplicate objects, especially complex ones.

1. Select Copy .

2. Anywhere select Paste .

right mouse click

drag
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3. The object is duplicated even though only two-fold text can be seen.

4. Keep the left mouse button pressed and drag the new object to its intended 
place.

Lock/Unlock Command
Use this command to fix or unfix the position of objects. This immobilization 
may be especially helpful in case of an entire group of objects in order to 
preserve their positions relative to each other.

To select several objects together one after another keep the <Ctrl> key 
pressed. Afterwards it is sufficient to click Lock/Unlock once to lock/unlock 
all objects selected. A locked object can not be deleted.

1. Select Lock/Unlock .

2. The position of the selected object is fixed (see the key symbol).

3. Clicking Lock/Unlock again will unfix its position (the key symbol 
disappears).

Delete Object Command

1. Press Delete Object .

2. The selected object will be deleted unless it is locked.

Alternative: Use the Delete button on the Page toolbar (see topic Page 
Toolbar on page 4-22).

Lock / Unlock
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Miscellaneous Features

This chapter contains the following topics:

• Acquisition Mode and Workspace Mode
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5.1 Acquisition Mode and Workspace 
Mode

Principle: The well-known dialectic discrimination between “Dual Inlet” 
Mode and “Continuous Flow Mode” as applications has been 
abandoned. Instead, only one Acquisition Mode exists 
encompassing both of them.

In addition to Acquisition Mode, a nearly identical Workspace 
Mode is available. Workspace Mode allows creation of new 
elements (i.e. Isodat methods, GC methods, AS methods, 
sequences, Excel templates) and even evaluation during data 
acquisition. Any tools and files known from Acquisition Mode 
are available in Workspace Mode as well. However, only data 
acquisition is impossible in the latter.
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Index

A
A200S, 1-42

method, 1-61
abbreviations, vii
accessing

ratios in gas configuration, 2-22
Accessories toolbar, 4-4
acquisition

control, external, 1-4
mode, 1-41, 5-2

actions
directly related to sample injection, 1-63
taken after sample injection, 1-64
taken before injection, 1-62

adding
evaluation to evaluations list, 2-10
gas to filter list, 2-12

adjusting
objects relative to page margins, 4-28
objects relative to selected object, 4-26
properties of external device, 1-32

advanced mode, 1-3
Agilent 6890 GC, 1-39

method, 1-47
analyzing

object, 1-12
appending objects from file, 4-25
application mode, 1-30
arranging

objects, 1-27
Arrow icon, 4-32
AS method, 1-69, 5-2

disabling, 1-71
AS2000, 1-42

method, 1-64
autosize, 4-35

B
Back tab, 1-59
bar

changing dimensions, 3-24
Basic toolbar, 4-20
bitmap, 1-23

visual object, 1-23
blocks, commenting, 3-4
bookmarks, 3-22
borders

creating, 1-12
box, 1-13, 3-8
Break command, 3-10, 3-13
breakpoints, 3-10, 3-12
buttons

Add User Device, 1-4
combining with checkbox, 1-15
editing name, 1-16
Reset, 1-29
usage, 1-15

Visual Object, 1-10
Properties, 1-29

C
changing

appearance of guiding lines, 4-30
color properties, 4-45
font properties, 4-44
object type, 4-14
properties of objects, 4-43
size properties, 4-46
type properties, 4-45

checkbox, 1-15
dimensions, 1-15
marking/unmarking, 1-15

choosing standards, during method creation, 2-5
cleaning cycles, 1-65 to 1-66
Clear Bookmark command, 3-22
closing

ratio editor, 2-21
colors

background, 1-12
fill, 4-37, 4-46
keywords, 3-4
line, 4-46
shade, 4-40
text, 4-46

combining
graphical objects, 1-29

commands
Break, 3-10, 3-13
Clear Bookmark, 3-22
Control Break, 3-10
Copy, 4-47
Debug, 3-11
Delete Object, 4-48
Find, 3-20
Goto Definition, 3-6
Insert Device Item (All), 3-9
Insert Device Item (Cnf), 3-8
Insert Function, 3-7
Lock/Unlock, 4-48
Open File, 3-5
Options, 4-21
Paste, 4-47
Prg Ptr, 3-17
Properties, 4-47
Redo, 3-10, 4-21
Replace, 3-20
Run, 3-11
Save Dynamic Externals, 3-23
Set Bookmark, 3-22
Stick, 3-20, 4-20
Stop, 3-13
Undo, 3-10, 4-21
Zoom, 4-23

comment, 3-4
entire block, 3-4
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single line, 3-4
commenting out, lines or blocks, 3-4
configuration editor, 1-4
configurator, 1-32
constant flow mode, 1-56
constant pressure mode, 1-56
context menu, 1-24, 4-47

ISL editor, 3-5
continuous flow mode, 5-2
Control Break command, 3-10
conventions

typographical, xi
Copy command, 4-47
creating

borders, 1-12
dialogs, 1-10
library, 3-3
method, 2-2, 2-5
new elements, 5-2
new method for external device, 1-43
new printout template, 4-10
new sequence for external device, 1-68
new standard, 2-4
new user device, 1-4
printout templates, 4-5
run time events, 1-47
several printout templates, 4-11
visualization, 1-8

crosshair cursor, 4-32
cups

number, 2-25, 2-27
cursor, crosshair, 4-32
cycle, pull-up, 1-65

D
data

input, xi
output, xi
self-actualization, 4-9

database
ratio, 2-21
ratio group, 2-23

Debug
bar, and Watch command, 3-17
command, 3-11

debug mode, 3-10, 3-12
visualization, 3-13

debugging
scripts, 1-4

Delete Object command, 4-48
deleting objects, 1-6, 4-23
deselecting

object, 4-4
design

mode, 1-24
panel, 1-2, 1-8

Detector tab, 1-60
device

editor, 1-2, 1-2
hardware, 1-21

dialogs

creating, 1-10
dimensions, 1-13, 3-8

box, 1-13, 3-8
checkbox, 1-15

dual inlet mode, 5-2
duplicating

user device, 1-5
DVE, 3-26
dynamic externals

script editing, 1-18
Dynamic Variables Exchange (DVE), 3-26

E
edit mode, 4-15
editing

dynamic externals, 1-17
hardware components, 1-21
methods, 1-35
printout template, 4-13
script, 1-18
user device, 1-5

editors
gas configuration, 2-22
ISL, 3-2
panel, 1-8
ratio, 1-3, 2-8
standard, 1-3, 2-2

elements
creating, 5-2

erasing
graphic text, 4-41

error, 3-4
evaluation

ratios, 2-22
evaluation-related features, 2-1
evaluations, 2-23
evaluation, incorporating a second group of ratios, 2-18
Excel templates, 5-2
executing

script, 1-17
external

acquisition control, 1-4
data processing, 1-3
devices, method structure, 1-44
parameter set, 3-23

external device
adjusting properties, 1-32
creating a new method, 1-43
creating a new sequence, 1-68
creating new method, 1-43
creating new sequence, 1-68
properties, 1-32 to 1-33

F
features

evaluation-related, 2-1
hardware-related, 1-1
miscellaneous, 5-1
reporting-related, 4-1
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script-related, 3-1
file

appending objects from, 4-25
merging objects from, 4-25
result, 4-2, 4-7 to 4-8

file browser, 4-4
fill colors, 4-37, 4-46
filter list

adding a gas, 2-12
information about gases, 2-13

Find command, 3-20
finding out

content of variables, 3-5
flow

mode, 1-39
program, 1-57

flows, gas, 1-13
font properties, changing, 4-44
footer, 4-31
formats, graphic, 1-23
Front tab, 1-52
functions, 3-4, 3-19

control, 1-4
definition, 3-6
finding, 3-8
finding name, 3-7
inserting, 3-7 to 3-8
inserting peripheral, 3-9
internal, 3-4
ISL, 3-4
library, 3-4, 3-6 to 3-7
locating, 3-6
order, 3-19

G
gas

flows, 1-13
types, 4-2

gas configuration, 2-6, 2-22
accessing ratios, 2-22
editor, 2-22

gases in the filter list, information about, 2-13
GC method, 1-69, 5-2

disabling, 1-70
storage place, 1-72

General tab, 1-34, 1-64
Get button, 1-37, 1-43

usage, 1-35
Goto Definition command, 3-6
graphic formats, 1-23
graphical objects, combining, 1-29
group, ratio, 2-27
groupbox, 1-14
grouping

objects, 1-28
guidelines, 4-31
guiding lines, 4-30

distance, 4-31
switching on/off, 4-30

H
hardware

device, 1-21
parameters, 3-23
position, 1-37

hardware-related features, 1-1
header, 4-31
headings, xiii
hiding

Accessories toolbar, 4-5
bar, 3-24

I
incorporating

first group of ratios into active evaluation, 2-16
intermolecular ratio into active evaluation, 2-20
second group of ratios into active evaluation, 2-18

information bar, in ISL script, 3-24
information, about gases in the filter list, 2-13
injection modes, 1-52

pulsed split, 1-54
pulsed splitless, 1-54
split, 1-53
splitless, 1-53

inlet mode, dual, 5-2
inserting

acquisition time, 4-32
graphic, 4-38
grid, 4-34
Isodat object, 4-33
objects into the working grid, 4-42
result file name, 4-34
simple object, 4-36
text, 4-34
text file, 4-34
text object, 4-42

internal standard, 1-67
Internal Standard tab, 1-66
ISL

editor, 3-2
context menu, 3-5

toolbar, 3-10
ISL scripts

general remarks, 3-4

L
language, script, 3-2
library, 3-4, 3-6 to 3-7
line colors, 4-46
loading

printout template, 4-18
visualization, 1-30

locations
methods, 1-72

Lock/Unlock command, 4-48
locking

object, 1-28
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M
manual setup, 1-36
margins, page, 4-28
menu bar, 3-20

additional commands, 3-20
menu, context, 4-47
merging objects from file, 4-25
method

creating, 1-43, 2-2, 2-5
creation, choosing standards during, 2-5
manual upload, 1-51
structure, 1-44
structure of external devices, 1-44

methods
editing, 1-35
locations, 1-72

mode, edit, 4-15
modes

acquisition, 1-41, 5-2
advanced, 1-2 to 1-3
application, 1-30
constant flow, 1-56
constant pressure, 1-56
continuous flow, 5-2
debug, 3-10, 3-12
design, 1-24
dual inlet, 5-2
edit, 4-15
flow, 1-39
injection, 1-52
normal, 1-3
pressure, 1-39
pulsed split, 1-54
pulsed splitless, 1-54
ramped flow, 1-57
ramped pressure, 1-58
simulation, 1-15, 1-24
split, 1-53
splitless, 1-53
start, 1-43
stretching, 4-30
workspace, 5-2

modifying
object, 1-12

moving
bar, 3-24

multidimensionality, 4-2

N
navigating, through working grid, 4-23
new user device, creating a, 1-4
normal mode, 1-3
Notes

at size, dimensions will change to X2 = Y2, 4-41
Back tab only appears if you did not select None, 1-59
boxed information conventions, xii
creating/editing of user devices impossible in normal 

mode, 1-3

Detector tab only appears, if you did not select None, 
1-60

do not click on an existing device, 1-4
for details about injectors and detectors, refer to 

A200S autosampler manual, 1-42
for details about injectors and detectors, refer to 

AS2000 autosampler manual, 1-42
for details about injectors and detectors, refer to Trace 

GC manual, 1-34
for details injectors and detectors, refer to Agilent 6890 

GC manual, 1-39
Front tab only appears, if you did not select None, 1-52
Get button always enables upload of GC parameters, 

1-35
if you have a PAL autosampler, select A200S, 1-33
if you select "None", the respective tabs will not occur 

in the method, 1-36
if you unmark checkbox, parameters in frame will not 

be loaded, 1-55
if you unmark the checkbox, parameters in frame will 

not be loaded, 1-52
keep check box is always marked, 1-7
not only irw files can be appended, but also scn files 

and cal files, 4-25
online Help superscript type conventions, x
only bmp files are supported, 4-40
PAL autosamplers are run via A200S mode, 1-61
Shade checkbox must be marked for shade color to 

take effect, 4-41
specify injector(s) and detector(s) to let tabs appear, 

1-48
Thermo Electron supports SSL and OCl as injector 

types, but not PTV, 1-36
to mark/unmark checkbox, switch to simulation mode, 

1-15
two methods occur, 1-69
when Center checkbox is marked, rotation and offset 

changes will not take effect, 4-44
when creating a method, standard will be chosen from 

standard editor’s list, 2-2
when creating a method, standard will be chosen from 

standard editor’s list, 2-5
when creating a new file name, method is uploaded to 

method A200S-1 in the control panel, and this 
method is overwritten, 1-61

number, page, 4-31

O
object info tree, 4-24

viewing, 4-24
Object toolbar, 4-32
objects

adjusting, 4-26
analyzing, 1-12
arranging, 1-27
bitmap, 1-23
changing dimensions, 1-11, 4-46
changing properties, 4-43
changing type, 4-14
checkbox, 1-15
deleting, 1-6, 4-23, 4-48
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deselecting, 4-4
duplicating, 4-48
fixing position, 4-48
from file, appending, 4-25
from file, merging, 4-25
groupbox, 1-14
grouping, 1-28
inserting, 4-36
locking, 1-28
modifying, 1-12
pipe, 1-13
properties, 1-6, 1-13, 1-25, 4-4, 4-43
renaming, 1-6
rotating text, 4-44
size, 1-27
transparency, 1-13
type, changing, 4-14

offset, 4-44
Open File command, 3-5
opening

configurator, 1-2
different types of ISL scripts, 3-2
predefined printout template, 4-5
ratio editor, 2-8
ResultWorkshop, 4-3
script, 1-18
standard editor, 2-2

Options command, 4-21
Oven Method tab, 1-49
Oven tab, 1-45, 1-51

P
page

margins, 4-28
adjusting objects relative to, 4-28

number, 4-31
Page toolbar, 4-22
PAL setup, 1-61
panel

design, 1-2, 1-8
using graphical objects, 1-10
using hardware components, 1-10

editor, 1-8
parameter

control, 1-4
parameters

hardware, 3-23
Paste command, 4-47
peripheral, 3-8
picture, background, 1-12
pipe, 1-13

shape, 1-13
pointer variable, 3-18
pointer, program, 3-17
position

hardware, 1-37
pressure mode, 1-39
preview, print, 4-22
Prg Ptr command, 3-17
print preview, 4-22
printout templates, 4-5, 4-7, 4-11

creating, 4-5, 4-10
creating several, 4-11

processing, external data, 1-3
program pointer, 3-17
Properties

button, 1-29
command, 4-47

properties
external device, 1-32 to 1-33
object, 1-6, 1-13, 1-25, 4-4, 4-43

pull-up cycle, 1-65

R
ratio

database, 2-21
editor, 1-3, 2-8

closing, 2-21
groups, 2-23, 2-27

database, 2-23
ratios in the gas configuration, accessing, 2-22
Redo command, 3-10, 4-21
relationships, visualizing, 1-23
removing

user device, 1-5
renaming

object, 1-6
user device, 1-5

Replace command, 3-20
reply cards

Change of Location, xiv
Customer Registration/Reader Survey, xiv

reporting-related features, 4-1
Reset button, 1-29
result file, 4-2, 4-7 to 4-8
ResultWorkshop, 1-5, 4-2

principle, 4-2
Run

command, 3-11
Table tab, 1-47

Run Table tab, 1-47
run time events

creating, 1-47
run, temperature-programmed, 1-50

S
Save Dynamic Externals command, 3-23
saving

method for external device, 1-67
printout template, 4-17
visualization, 1-30

scaling
text, 1-12

script, 1-15
applying to button, 1-15
debug mode, 3-10
debugging, 3-10, 3-24
editing, 1-18

dynamic externals, 1-18
executing, 1-17
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interrupting execution, 3-13
language, 3-2
mode, 1-17
opening, 1-18
stopping execution, 3-13
terminating execution, 3-14
types, 3-3
variables, 3-18

script-related features, 3-1
selecting

objects, 1-26
several objects, 1-26

self-actualization, of data throughout different templates, 
4-8
sequences, 5-2
Set Bookmark command, 3-22
set, external parameter, 3-23
setup

manual, 1-36
PAL, 1-61
via ISODAT NT, 1-36
via Trace GC, 1-35

shade color, 4-40
showing

Accessories toolbar, 4-5
bar, 3-24

simulation mode, 1-15, 1-24
size

object, 1-27
properties, changing, 4-46

stacks
control, 1-4

standard
creating, 2-4
editor, 1-3, 2-2

principle, 2-2
internal, 1-67

standards during method creation, choosing, 2-5
start mode, 1-43
status bar, 4-22
Step in command, 3-14
Step out command, 3-14
Step over command, 3-14
Stick command, 3-20, 4-20
Stop command, 3-13
stretching modes, 4-30
string variable, 3-18
structure

A200S method, 1-61
Agilent 6890 GC method, 1-47
AS2000 method, 1-64
Trace GC method, 1-44

subscripts, 3-3
support, third party, 1-2, 1-32
switching, between objects, 4-4
syringe, 1-65

T
temperature ramps, 1-45
temperature-programmed run, 1-50
templates

Excel, 5-2
printout, 4-5, 4-7, 4-11

text
colors, 4-46
scaling, 1-12

text objects
inserting, 4-42

text, visual object, 1-11
third party support, 1-2, 1-32
threads

control, 1-4
toolbars, 4-19
Trace GC, 1-34

method, 1-44
type properties, changing, 4-45
types, gas, 4-2

U
Undo command, 3-10, 4-21
user device

creating, 1-4
duplicating, 1-5
editing, 1-5
new, 1-4
properties, 1-5
removing, 1-5
renaming, 1-5
visualization, 1-8

V
variables

content, 3-5
control, 1-4
external, 3-26
ISL, 3-4
pointer, 3-18
string, 3-18
types, 3-18

Variables tab, 3-17
view object info tree, 4-24
visual objects

bitmap, 1-23
button

script editing, 1-15
checkbox, 1-15
groupbox, 1-14
pipe, 1-13
text, 1-11

visualization
saving, 1-30

W
Watch command, and Debug bar, 3-17
working

grids, 4-11
navigating through, 4-23

standards, 2-6
workspace mode, 5-2
Thermo
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Z
Zoom commands, 4-23
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